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1. Getting Started
This Section is intended as a quick start introduction for
running the TRANSPORT Application Module in the
Particle Beam Optics Laboratory. The remainder of this
Supplement describes the PBO Lab user interface features
that are specific to the TRANSPORT Application Module.
Refer to the PBO Lab User Manual for more general
information on the PBO Lab user interface. The
“TRANSPORT User Manual” describes the
TRANSPORT program.

Running TRANSPORT
Execution of TRANSPORT is accomplished from the
Commands Submenu, shown in Figure 1, by selecting one
of the Write Input and Run Transport commands.

Figure 1. TRANSPORT Commands Menu.

The Write Input and Run Transport command provides
options for running TRANSPORT with or without Fitting.
Both options will generate the native input and execute
TRANSPORT for the beamline in the Model Space of
the Document Window. The second command in this
group opens the Transport Plot Specifications Window.

The next group of commands provide options to separate
the generation of input from the execution of TRANSPORT.

The next group of commands is for the display of diagnostic
data, followed by a Submenu that provides access to user-
specified Named Parameters, Variables, Expressions and
Fitting Constraints for the entire beamline.

This Supplement describes the user
interface features specific to the
TRANSPORT Application Module.
Refer to the main PBO Lab User
Manual for more general information
on the PBO Lab user interface. Refer
to the “TRANSPORT User Manual” for
a description of the TRANSPORT
program.

The Commands Submenu for
TRANSPORT is used to set various
options and output parameters for
the TRANSPORT Application Module
as described in this Supplement.

PBO Lab provides a group of
commands that can be used to
generate the native TRANSPORT input
independently from the execution of
the TRANSPORT program.  Using
these commands allows the input
generated by PBO Lab to be modified
directly before running TRANSPORT.

PBO Lab 2.0 User Manual Supplement: TRANSPORT Module
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The last command in the TRANSPORT Commands menu
is used to access various options and output parameters.

To Run the TRANSPORT Application Module simply
select the command to Write Input and Run Transport
without Fitting from the Commands Menu as illustrated
in Figure 2. The native Transport Output file is
automatically displayed in a scrollable Text Edit Window
upon completion of the run. Use the Save As command
in the File Menu of the Text Edit Window to rename the
output file if desired. Both the Transport Input and Output
files will be overwritten on any subsequent execution of
the TRANSPORT Application Module.

Selecting the first item in the TRANSPORT 
Commands Menu generates the native 

Transport Input  for the beamline model in 
the Document Window and then executes the 

TRANSPORT Application Module

Figure 2. Executing the TRANSPORT Application Module.
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Figure 2 is an example of the output
window that is displayed when the
TRANSPORT run is completed. The
content of the native Transport
Output file will depend on various
options and output parameters set
by the user.

Figure 2 illustrates the selection of the first command,
which will write the native Transport Input file and run
TRANSPORT for the current beamline model. The
selected command is executed after the mouse button is
released. Following execution, the Transport Output file
will be displayed, as illustrated in Figure 2.

PBO Lab also provides graphic representations of data
generated from TRANSPORT. The Transport Plot
Specification command in the Commands Menu can be
used to direct output to the Transport Plot file which is
used by PBO Lab to generate interactive graph plots. Any
plot specifications will result in PBO Lab Graph Plot
Windows being opened automatically after execution of
TRANSPORT. A description of Transport Plot
Specifications can be found in Chapter 8 of this
Supplement. The user interface for Graph Plot Windows
is described in the main PBO Lab User Manual.
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2. TRANSPORT Application Module
This Section describes the PBO Lab Application Context and
Global Parameters that are specific to the TRANSPORT
Application Module. Refer to the Getting Started and User
Interface Chapters of the PBO Lab User Manual for more
general information on the PBO Lab user interface. The
“TRANSPORT User Manual,” included with this
Supplement, describes the TRANSPORT program in general
and each of the native TRANSPORT input parameters.

Tab Panels provide access to 
additional Global Parameters 
and Initial Floor Coordinates 

for the beamline model

Green dots indicate which  Parameters 
are native inputs for TRANSPORT 

Set the Application Context pop-up for 
the TRANSPORT  Application Module

Figure 3. TRANSPORT Application Context and Global Parameters.

The Application Context pop-up in the Button Bar of the
Document Window is shown in Figure 3. The Application
Context does not need to be set for TRANSPORT in order
to execute TRANSPORT commands. However, the
Application Context is used to indicate which input
parameters are native inputs for TRANSPORT. Native
inputs are indicated in the Global Parameters and in each
Piece Window using green dots that appear to the right of
a parameter.

The Application Context is used to
identify native parameters with green
dot indicators.

The Application Context is also used
to activate any application-specific
buttons and in some cases, to
determine which application-specific
windows will be opened.

PBO Lab 2.0 User Manual Supplement: TRANSPORT Module
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Beamline Global Parameters
The PBO Lab Beamline Global Parameters are described
in the Getting Started and User Interface Chapters of the
PBO Lab User Manual. This Section discusses the Global
Parameters that are used by the TRANSPORT Application
Module.

The native Global Parameters for TRANSPORT include
the Particle Charge, Particle Mass, Beam Energy and
Frequency. These parameters are indicated with green dots
when the Application Context is set for TRANSPORT in
the Document Window, as shown in Figures 3 and 4.

The PBO Lab Global Parameters
include native TRANSPORT inputs such
as the Particle Charge, Particle Mass,
Energy and Frequency, which are
global to the entire beamline model.

Hide and Show the Global 
Parameters from the View 

Menu or the Button Bar

The Beamline Global Parameters 
are accessed from three tab panels 
that float over the Work Space of 

the Document Window

Figure 4. Beamline Global Parameters in the Document Window.
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The Particle Charge Global Parameter is not a native
TRANSPORT input. However, PBO Lab does use another
native TRANSPORT input, PREF in order to scale all
magnetic fields to a “reference momentum”, which is
different from the beam momentum “PO”. Internally
TRANSPORT converts all fields by the ratio of PO/PREF
and in the native Transport Output file, the scaled fields
are printed. The use of PREF in TRANSPORT is described
in the “TRANSPORT User Manual” included with this
Supplement. PBO Lab calculates an effective PREF and
writes it to the Transport Input file, handling all other
necessary conversions as well.

Several of the Global Parameters are also used for a variety
of PBO Lab calculations and displays, although they may
not be native inputs for TRANSPORT. Additional Global
Parameters are accessed from the Tracing/Tracking tab
panel and the Floor Coordinates tab panel as illustrated
in Figure 4 on the previous page.

The Tracing/Tracking Global Parameters tab panel (Figure
4) has inputs that are used by both the TURTLE and
MARYLIE Application Modules. These parameters are
described in each of the Supplements for those Application
Modules. The Tracing/Tracking Global Parameters are not
used by the TRANSPORT Application Module.

Initial Floor Coordinates and
Orientation Parameters

Included with the beamline Global Parameters are a set
of Initial Floor Coordinate Parameters of the beam
reference trajectory, which are shown in Figure 4. These
parameters are used to specify the initial coordinates and
the orientation of the reference trajectory. If these
parameters are zero (default values are zero) then
TRANSPORT assumes that the beamline will start at the
origin and proceed along the positive z-axis. Floor plots
are specified in the Transport Plot Specification Window
described in Chapter 8 of this Supplement.

Although the Particle Charge is not
a native TRANSPORT input, PBO Lab
utilizes another TRANSPORT native
input parameter, PREF, that is used
to scale all magnetic fields to a
“reference momentum” which is
different from the beam momentum.

A green dot next to a parameter
indicates that it is a native input for
the current Application Context set
in the Document Window.

The Tracking and Tracing Global
Parameters are not used by the
TRANSPORT Application Module.

Included with the PBO Lab Global
Parameters are the Initial Floor
Coordinates and Orientation inputs
that are used by TRANSPORT.
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3. Beamline Elements
The PBO Lab Pieces implemented for TRANSPORT are
listed in Table 1 below. Native TRANSPORT inputs for
these elements are indicated in the Piece Windows. As
with the Global Parameters, green dots are found to the
right of Piece Parameters that are native inputs. (The
Application Context must be set for TRANSPORT in the
Button Bar of the Document Window.)

Table 1. PBO Lab Pieces supported by TRANSPORT.

The Piece Window user interface is described in the Getting
Started and User Interface Chapters of the PBO Lab User
Manual. However, several pieces have features that are
specific to TRANSPORT and those are described separately
in this Chapter. The “TRANSPORT User Manual”
(included with this Supplement) describes the
implementation of the other elements supported by the
TRANSPORT Application Module in PBO Lab. Many
Pieces also provide run-time Tutorials that are accessed from
the Tutorial buttons in the Piece Windows.

Table 1 lists all of the Pieces that are
recognized by TRANSPORT. Pieces in
the beamline model that are not
supported by TRANSPORT will be
treated as zero-length drifts when
PBO Lab generates the native input
for TRANSPORT.

Beam Bend Accelerator Eta

Drift Edge Align Param

Quadrupole Lens Kicker Special

Solenoid Plasma Lens ∆RMS Marker

RF Gap Sextupole Rotate Final

Sector Bend Octupole Septum

Rectangular Centroid Matrix
Bend

PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

15



PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

16

Beam Piece
PBO Lab uses the Beam Piece to generate the initial
Sigma-Matrix for TRANSPORT. The beamline model
must include a Beam Piece, usually as the first piece in
the beamline as illustrated in Figure 5. The Beam Piece is
used to specify the initial Sigma-Matrix for TRANSPORT
in two different ways, referred to as the Semi-Axes
representation and the Twiss, or Courant-Snyder
representation. The Semi-Axes representation is more
general and allows for the complete specification of any
Sigma-Matrix, including correlations between different
phase planes. The Twiss parameter representation is useful
for specifying initial beams in which the phase planes
(horizontal, vertical and longitudinal) are decoupled.
TRANSPORT permits the use of the Twiss parameter
representation only for the transverse phase planes
(horizontal and vertical) of the initial beam.

Double-click the Beam Piece 
to Access Beam Parameters

Set the Application Context 
for TRANSPORT

Figure 5. Initial Beam Parameters in the Beam Piece Window.

Beam Piece

The beamline model must include a
Beam Piece in order to generate the
native beam inputs for TRANSPORT.

The native beam inputs for
TRANSPORT can be generated from
either the Semi-Axes or Twiss Beam
Piece Parameters.

TRANSPORT permits the use of the
Twiss parameter representation only for
the transverse phase planes (horizontal
and vertical) of the initial beam.
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Both the Semi-Axes and Twiss parameters are shown in
Figure 6 illustrating the Beam Piece Window. There is a
Button Bar at the top of the window, two tab panels for
parameter inputs (Beam and Centroid Parameters) and a
set of dynamic phase space ellipse plots. The Centroid tab
panel of the Beam Piece is not used by TRANSPORT.
However, PBO Lab does provide a Centroid Piece that is
supported by TRANSPORT. The Particle Distribution Type
pop-up does not apply to TRANSPORT but the Beam
Parameters pop-up is used to select between the Semi-Axes
and Courant-Snyder (Twiss) beam parameter sets.

Transverse and Longitudinal 
Phase Space Ellipse Plots are 
Provided for Beam Parameters

Select between Semi-Axes or 
Courant-Snyder (Twiss) Beam 

Parameter Representations

The Tutorial Button Opens the 
Beam Piece Tutorial window, 
which Provides a Variety of 

Information on Beam Parameters

Green Dots Indicate which 
Parameters will be used to 
Generate the Native Inputs 

for TRANSPORT

Open the TRANSPORT Correlations Matrix 
Window with Semi-Axes Parameters Selected

Compute Semi-Axes Parameters from Twiss Parameters
or Compute Twiss Parameters from Semi-Axes

Auto-Scale Phase Space 
Ellipse Plots or Set the 

Plot Scales Directly

Figure 6 Semi-Axes and Twiss Beam Piece Parameters.

The Centroid Piece can be used to
shift the centroid trajectory of the
beam, relative to the reference
trajectory, or axis, of the beamline.

The Beam Parameters pop-up is used
to select between the two independent
parameter sets for Semi-Axes or
Courant-Snyder beam representations.



PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

18

The two different beam parameter sets (Semi-Axis and
Twiss) are independent, although one set may be
calculated from the other. When the Twiss Beam
Parameters are selected, the Compute From Semi-Axes
button will calculate the equivalent Twiss parameters for
the current Semi-Axes parameters. When the Semi-Axes
parameter set is selected the Compute From Twiss button
will calculate the equivalent Semi-Axes parameters for
the current Twiss parameters. The Compute From... button
is in the Button Bar at the top of the Beam Piece Window.

When Semi-Axes Beam Parameters are selected,
correlations may be included in the beam description using
the Correlations button in the Button Bar of the Beam
Piece Window. The Correlations button opens the
Correlation Matrix Window shown in Figure 7.
Correlations may be entered directly as off-diagonal
elements of the Sigma Matrix, or by entering values for
the Reduced Sigma Matrix. The radio buttons at the top
of the window toggle between these two modes.
Corresponding values are calculated for the inactive
selection using the inputs from the active selection.

Radio buttons are used to select 
between the Sigma Matrix or the 

Reduced Sigma Matrix inputs

Figure 7. TRANSPORT Correlation Matrix Window.

The two different beam parameter
sets are independent, although one
set may be calculated from the other.

The green dots to the right of
individual parameters in the Piece
Windows indicate which will be used
to generate TRANSPORT input.

The Semi-Axes beam representation
includes a correlation matrix in the
beam description.

The Beam Correlations Matrix Window
is opened with the  Correlations button
in the Beam Piece Window.

Correlations may be entered directly
as off-diagonal elements of the
Sigma Matrix, or by entering values
for the Reduced Sigma Matrix.
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The Beam Piece Window includes dynamic phase space
ellipse plots for the current beam parameters. The top plot
shows the horizontal (red) and vertical (blue) transverse
phase space ellipses. The bottom plot is the longitudinal
(green) phase space ellipse. The axis scales for the phase
space ellipse plots can be calculated automatically with
the Auto Scale Plots button in the Button Bar at the top of
the window or the scales may be set directly by the user
with the Set Plot Scale button.

The Tutorial button in the Button Bar at the top of the
Beam Piece Window opens the PBO Lab Tutorial for the
Beam Piece and leads to the Hypertext Tutorial shown in
Figure 8. The Beam Piece Tutorial provides a variety of
useful information including descriptions of the beam
Sigma Matrix, Semi-Axes and Twiss parameter
representations, phase space projections, the beam
centroid and several other related topics.

The Beam Piece Window includes
phase space ellipse plots for the
current Beam Parameters.

The Beam Piece Tutorial provides a
variety of useful information on
modeling beams in TRANSPORT.

Figure 8. PBO Lab Beam Piece Tutorial Windows.
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Marker Piece
The Marker Piece is a special PBO Lab Piece that is used
to specify application-specific Constraints, Diagnostics
and Stored Parameters at specific locations in the beamline
model. An example of the Marker Piece Window is shown
in Figure 9.

     

Marker and Final Pieces

Open a TRANSPORT  
Stored Parameters Window

Open a TRANSPORT 
Fitting ConstraintsWindow

Open a TRANSPORT 
DiagnosticsWindow

TRANSPORT 
Application Context

The Marker Piece is used to Specify 
Application-Specific Constraints and 

Diagnostics at the Location of the 
Marker Piece in the Beamline Model

Figure 9. Marker Piece Constraints, Diagnostics and Stored Parameters.

There are three scrollable lists in the Marker Piece Window
that display selected Constraints, Diagnostics and Stored
Parameters for installed Application Modules. The example
in Figure 9 has Constraints specified for both the
TRANSPORT and MARYLIE Application Modules.
Diagnostics have been selected for TRANSPORT and
TURTLE. Stored Parameters are specified for TRANSPORT
only. Application-specific windows, tailored to the particular
capabilities of each Application Module, are used to specify
Constraints, Diagnostics and Stored Parameters.

Marker Piece

The Marker and Final Pieces may be
used to specify locations in the
beamline where a Constraint is to be
be imposed, Diagnostic data is to be
output or Stored Parameter data is
to be collected.
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The Application Context pop-up must
be set for TRANSPORT in order to
open the TRANSPORT windows for
Constraints, Diagnostics and Stored
Parameters.

The Application Context must be 
set for TRANSPORT to Open the 

Constraints, Diagnostics and 
Stored Parameters Windows

Figure 10. Location Specific Constraints, Diagnostics and Stored Parameters.

The Open buttons in each panel of the Marker Piece
Window are used to open the application-specific windows
for the current Application Context. In order to open the
TRANSPORT application-specific windows for
Constraints, Diagnostics and Stored Parameters the
Application Context pop-up must be set for
TRANSPORT as illustrated in Figures 9 and 10 The
Application Context can be set in either the Document
Window or directly in the Marker Piece Window.
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Location-Specific Constraints
The Open button in the Constraints panel opens the
Transport Fitting Constraints Window as illustrated in
Figure 10. Refer to the Transport Fitting Chapter for a
description of using the Marker Piece for location specific
fitting constraints.

Location-Specific Diagnostics
The Open button in the Diagnostics panel of the Marker
Piece Window opens the Transport Location Marker
Window. This window, shown in Figure 11, is tailored to
the particular capabilities of TRANSPORT for generating
output for specific locations in the beamline model. There
are three panels in the window for selecting various options
at the location of the Marker Piece in the beamline model.
The Print panel provides a variety of diagnostic output
options that will result in location-specific data written to
the Transport Output file. The Misalignment and
Initialization panels have options for location-specific
commands that are used for misalignment and re-
initialization of the R1 and/or R2 transfer matrices.

The Marker Label (Comment) is entered in the 
text field at the bottom of the window

A check box is also provided to use the Label as a 
Reference Marker in the Transport Input File

The Transport Location Marker Window, opened from the 
Diagnostics Panel in the Marker Piece Window, includes panels 

for Print Options as well as Misalignment and Initializations

Figure 11. Transport Location Marker Window.

Refer to the TRANSPORT Fitting
Chapter for a description of using the
PBO Lab Marker Piece for the
specification of TRANSPORT Fitting
Constraints.

Many of the Print options in the
Transport Location Marker Window
can also be selected in the
Transport Options Window for the
end of the beamline model or after
every element in the beamline.
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Location-Specific
Stored Output Parameters

The Open button in the Store panel of the Marker Piece
Window opens the Transport Stored Parameters Window
shown in Figure 12. This window is used to specify the
storage of TRANSPORT parameters at the location of the
Marker Piece in the beamline model. Stored Parameters
are shown in the TRANSPORT Output file and can also
be used in Algebraic Parameter Expressions or in Fitting
Constraint Expressions.

It is not necessary to know all of the TRANSPORT
keywords, the Stored Parameters Window provides user
friendly controls for selecting any applicable
TRANSPORT output parameters.

Refer to Table 5 in the
TRANSPORT Fitting Chapter for a list
of TRANSPORT keywords.

Refer to the “TRANSPORT User
Manual” for a description of
individual output parameters that can
be stored.

A complete range of matrix 
elements can be selected with the 

radio buttons and the matrix panel.

The application-specific Keyword 
is generated by the user interface 

when a selection is made.

The symbolic name for 
Stored Parameters can be 

specified by the user.

Figure 12. TRANSPORT Stored Parameters Window.
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To specify a Stored Output Parameter, enter a symbolic
parameter name in the Storage Name input field at the
top of the window. Stored Parameter Names should be
unique. They should not be identical to any Parameter
Names that have been defined for special parameter
settings or other Stored Parameters. Note that creating a
copy of a Marker Piece will also copy any Stored
Parameters that have been defined for that Piece. This will
result in duplicate Stored Parameter Names on the two
Marker Pieces. The duplicate names will be sent to
TRANSPORT but the value for the first parameter will
be overwritten when the second parameter is encountered.

After a Storage Name has been entered, a TRANSPORT
output parameter can be selected from the five different
matrices or the four pop-up controls. To select a matrix
element, first select the radio button for the desired matrix:
Beam Matrix, Correlation Matrix, R-Matrix, T-Matrix or
U-Matrix. Then a matrix element can be selected by
clicking on the desired element in the matrix panel. The
R-, T-, and U-Matrices also have pop-up controls to choose
between Regular or Auxiliary matrices. The T- and U-
Matrices have pop-ups for the additional dimensions of
these matrices. The matrix panel is used to select elements
for all of the matrices and it will reflect the corresponding
elements when a matrix radio button is selected. After a
selection has been made, use the Accept button to add it
to the storage list at the bottom of the window.

In addition to matrix elements, there are four pop-ups that
may be selected from: Beam Envelope and Beam Centroid
parameters, Lattice Functions and Floor Coordinates.
After a selection has been made from any of these pop-
ups, the Accept button is used to add it to the storage list
at the bottom of the window.

All of the special parameter settings for a PBO Lab
beamline model, including any Stored Parameter
specifications, are saved using the Save or Save As
commands in the File Menu of the Document Window.

To Store a TRANSPORT Output
Parameter, enter a unique parameter
name in the Storage Name input field
and select the Output Parameter with
the controls provided in the Stored
Parameters Window.

Copying Marker Pieces with Stored
Parameters will duplicate Parameter
Names and may result in unintended
consequences.

Stored Output Parameters can be
selected from the five different
matrices or the four pop-up controls
in the Stored Parameters Window.

Stored Output Parameters are saved
with the beamline model document.
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Stored Parameters List Window
PBO Lab provides application-specific interactive List
Windows that organize related data for the entire beamline
model. The Stored Parameters List Window contains a
list of location-specific Stored Output Parameters. Figure
13 illustrates opening the Stored Parameters List Window
from the List Windows Submenu in the TRANSPORT
Commands Menu.

The Stored Parameters List Window can be used to quickly
access Marker and Final Pieces with user-specified Stored
Parameters. Double-clicking an entry in the window will
open the associated Marker (or Final) Piece Window in
the beamline model.

To resize a column in a List Window, place the mouse
over the divider line in the column header. When the arrow
turns into a cross-hair, resize by holding the mouse button
down while dragging horizontally.

All of the user-specified Stored
Output Parameters can be accessed
from a convenient List Window.

Double-click an entry in the List
Window to open the associated
Marker (or Final) Piece Window in the
beamline model.

The header at the top of the List
Window can be used to adjust the
width of each column in the window.

Figure 13. Opening the List Window for Stored Output Parameters.
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Parameter Piece
PBO Lab provides a Parameter (Param) Piece for user
specified model parameters. A Param Piece may be
inserted anywhere in the beamline model as illustrated in
Figure 14. A Param Piece may also be placed on the Work
Space and referenced from Pieces in the beamline model.
Each Param Piece can be used to specify up to eight user
defined parameters. The Param Piece supports Special
Parameter Settings that are accessed with the “S” buttons
to the left of each parameter in the Param Piece Window.

Parameter (Param) Piece

Param Pieces may be placed in the
Model Space or the Work Space.
Param Piece Parameters can then be
referenced from Pieces in the
beamline model.

Each Param Piece Supports up to 
eight user defined Parameters

Double-Click the Param Piece 
Icon in the Document Window to 

Open the Param Piece Window

A Param Piece may be Placed 
Anywhere in the Beamline Model

Figure 14. Parameter (Param) Piece Window.

The S-Buttons open Special Parameter Settings Windows
(S-Windows) as illustrated in Figure 15. In the S-Window,
a Param Piece Parameter may be defined as a numerical
Value and used as a symbolic constant in Parameter
Algebraic Expressions. They may also be selected as
Fitting Variables or they may be specified by Algebraic
Expressions. However, unlike other beamline elements,
the Param Piece requires a Symbolic Parameter Name to
be specified for each of the special parameter settings

Refer to the Section on Special
Parameter Settings in this Chapter.

Param Piece Parameters require a
Symbolic Parameter Name to be
specified for each of the special
parameter settings options.
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options. A Param Piece Parameter will only be written to
the Transport Input file if a Symbolic Parameter Name
has been specified in the S-Window.

The Transport Tab Panel in the Special 
Parameter Settings Windows (S-Windows) 

is used to specify a Param for Transport

The Parameter Name for a Defined Param 
may be used anywhere in the Beamline 
Model to Define Algebraic Parameter 

Expressions for other Piece Parameters

A Symbolic Parameter Name must be 
Defined in the S-Window in order to use 
a Param Piece Parameter with Transport

Figure 15. Param Piece Special Parameter Settings.

A Param Piece Parameter may also be selected as an
Import Parameter in the Special Parameter Settings
Window. Refer to the External Data Interface Section in
the main PBO Lab User Manual for a description of Import
Parameters.

The Special Parameter Settings Chapter describes the S-
Window in more detail.

Avoid using a Symbolic Parameter
Name that is the same as a Piece
Comment. This can cause unintended
consequences when running
TRANSPORT.
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Matrix Piece
The PBO Lab Matrix Piece is supported by the
TRANSPORT Application Module and provides a means
to represent any arbitrary transformation matrix. First-,
Second- and Third-Order matrix elements may be
specified directly in the Matrix Piece Window, which is
illustrated in Figure 16 below. Alternatively, PBO Lab can
use TRANSPORT to calculate the transfer matrix for a
selection of one or more Pieces in the beamline model or
for the entire beamline.

Matrix Piece

The Radio Buttons and Pop-up 
Controls at the top of the Matrix 

Piece Window provide access to the 
First-Order R-Matrix, Second-Order 
T-Matrix and Third-Order U-Matrix

Individual Matrix Elements can be 
edited directly in the Matrix Panel

Figure 16. Matrix Piece Window.

Radio buttons at the top of the Matrix Piece Window are
used to toggle between the R-Matrix, T-Matrix and U-
Matrix displays. The R-Matrix represents the First-Order
transfer matrix R(i,j), displayed in meters and inverse
meters. When the T-Matrix radio button is selected, the
Second-Order matrix T(i,j,k), is displayed. The elements
of the T-Matrix have an additional index that is selected
with the pop-up to the right of the T-Matrix radio button.
The Third-Order U-Matrix U(i,j,k,l), is selected with the
U-Matrix radio button and has two additional dimensions
that are also selected with pop-up controls located to the
right of the U-Matrix radio button. The pop-up controls
for the T and U matrices are only activated when the
corresponding radio button has been selected.

The radio buttons and pop-up
controls at the top of the Matrix Piece
Window provide access to the First-
Second- and Third-Order transfer
matrices.
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A Matrix Piece can be placed in the beamline model or
on the Work Space by dragging the Matrix Piece icon
from the Palette Bar of the Document Window. The default
Matrix Piece Parameters represent the identity matrix.
Matrix elements can be entered directly into the Matrix
Piece Window.

A Matrix Piece can be also be generated for a selection of
beamline elements using the Create Matrix command. After
making a selection of Pieces in the beamline model, use the
Create Matrix command in the TRANSPORT Commands
Menu to generate a Matrix Piece on the Work Space that
represents the selected beamline elements. Refer to the Create
Matrix Command Section in Chapter 6: Displaying and
Creating Matrices.

The Matrix Piece may be useful for speeding up
TRANSPORT calculations for very large beamline
models. For example, in a typical fitting calculation (Refer
to Chapter 9: TRANSPORT Fitting) only a few Pieces
will have Variable Parameters specified. The other static
parts of the beamline may be replaced by Matrix Pieces
generated as described in the preceding paragraph.

A Matrix Piece can also be generated for the entire
beamline model from the Transport R-Matrix Window.
After executing TRANSPORT the Show R-Matrix
command will open the R-Matrix Window and the Create
Matrix button will generate a Matrix Piece representing
the entire beamline. Refer to the Creating a Matrix Piece
Section in Chapter 6: Displaying and Creating Matrices.

PBO Lab provides an Output File Option in the
TRANSPORT Options Window that causes
TRANSPORT to generate the transverse matrix
components in millimeters and milliradians. This mixed
units representation will only appear in the Transport
Output File when this option is selected. The Matrix Piece
Window will always display the matrix data in meters
and inverse meters regardless of the TRANSPORT Output
File Option.

An arbitrary transfer matrix can be
defined directly in the Matrix Piece
Window.

A Matrix Piece can be generated for
a selection of one or more elements
in the beamline model.

A Matrix Piece can be created for the
entire beamline after executing
TRANSPORT.

The Matrix Piece Window displays the
transfer matrices in units of meters,
radians and inverse meters, radians
regardless of the TRANSPORT Output
File Option.

Matrix Pieces may be used to replace
static sections of a large beamline. If
acceleration elements are in the
beamline, Special Pieces may need to
be added to change the beam (P0)
or reference (PREF) momentum. Refer
to the following Section for a
discussion of the Special Piece.
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Special Piece
The PBO Lab Special Piece is used by the
TRANSPORT and TURTLE Application Modules. The
Special Piece Window, shown in Figure 17, contains five
tab panels. The first four tab panels are used exclusively
for TRANSPORT. The fifth tab panel is used for the
TURTLE Application Module.

Special Piece

The Special Piece is provided for the 
definition of location specific Special 
Parameters that can be used to change  

TRANSPORT System, Floor Coordinate, 
Fringe Field and Expansion Parameters

Figure 17. Tab Panels in the Special Piece Window.

The Special Piece is provided for the definition of location
specific special parameters that can be used to change
TRANSPORT System, Floor Coordinate, Fringe Field and
Expansion Parameters. Table 2 list the Special Parameters
and the corresponding TRANSPORT keywords.
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Table 2. Special Piece Parameters and Keywords.

Special Piece Parameter TRANSPORT
Keyword

System Parameters
System Length LENGTH
Reference Trajectory Momentum P0
Magnetic Field Reference Momentum PREF
Particle Mass PMASS
Tilt to Focal Plane FOTILT
Floor Coordinate Parameters
Horizontal Location XBEGIN
Vertical Location YBEGIN
Longitudinal Location ZBEGIN
Y-Axis Angle YAW
X-Axis Angle PITCH
Fringe Field Parameters
Horizontal Half-Width HWIDTH
Half Pole Spacing HGAP
Orbit Displacement Integral FINT0
Fringe Field Factor K1 FINT
Fringe Field Factor K2 FINT2
Entrance Pole-Face Curvature H1
Exit Pole-Face Curvature H2
Expansion Parameters
Second-Order Field EPS
Third-Order Field EPS3
Excess Field Fraction RMPS
Field Scaling Factor RNMS
Vertical Dipole Factor VR
Vertical Gradient Factor NP
Vertical Sextupole Factor EPSP

The Special Piece can be placed anywhere in the beamline
by dragging the icon from the Palette Bar of the Document
Window and inserting it at the desired location in the beamline
model. Special Pieces on the Work Space are ignored when
generating special instructions (SPEC cards) in the
TRANSPORT input file. Special Pieces must precede any
element(s) to which they apply. Once a Special Parameter
has been defined at a specific location in the beamline, it
will apply to all succeeding elements of the appropriate type
unless reset to a new value.

Special Pieces must precede any
element(s) to which they apply. Once
a Special Parameter has been defined
for a location in the beamline model,
it will apply to all succeeding
elements that are the appropriate
type unless reset to a new value.

PBO Lab will only use Special
Parameters that have been defined
by a Symbolic Parameter Name in the
parameters’ Special Parameter
Settings Window.

Note that the Fringe Field Factor K2
(FINT2) is no longer used by
TRANSPORT, but is included for
compatibility with older versions.

Refer to the “TRANSPORT User
Manual” for a description of
individual special parameters.

Special Pieces on the Work Space
are ignored when generating
special instructions (SPEC cards) in
the TRANSPORT input file.



A single Special Piece may be used to define multiple
Special Parameters for a specific location in the beamline.
Multiple Special Pieces can also be placed at different
locations in the beamline to redefine a single Special
Parameter. However, PBO Lab will only use Special
Parameters that have been defined by a Symbolic Parameter
Name in the parameter’s Special Parameter Settings
Window, as illustrated in Figure 18. Special Parameters
should be defined with unique Parameter Names,
particularly when the same Special Parameter is defined at
different locations in the beamline model, otherwise the
last non-unique Parameter Name and Value will be used
for each Special Parameter defined by that Name. Copying
a Special Parameter Piece will also copy any Special
Parameter Settings including Symbolic Parameter Names.
When a Special Piece is copied, care should be taken to
assign unique Symbolic Parameter Names.

Only Special Parameters that have
been defined by a Symbolic
Parameter Name in the parameters’
Special Parameter Settings Window
will be used by TRANSPORT.

Copying Special Pieces wil l
duplicate any Symbolic Parameter
Names and may result in
unintended consequences.

Special Parameters must be defined by a 
Symbolic Parameter Name in the Special 

Parameter Settings Window that is accessed 
using the parameter's "S-Button"

Figure 18. Defining a Symbolic Parameter Name for a Special Parameter.

Refer to the following Chapter for a description of the
Special Parameter Settings Window.
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Refer to the Piece Window Section
in the PBO Lab User Manual for a
complete description of the Piece
Window user interface.

Access Special Parameter Settings
Windows with the S-Button to the
left of the desired parameter in the
Piece Window.

4. Special Parameter Settings
Many Piece Parameters support application-specific
special parameter settings that are accessed with the
Special Parameter Settings Buttons (“S-Buttons”) located
next to each parameter in PBO Lab Piece Windows. The
S-Buttons open a Special Parameter Settings Window (“S-
Window”) for the associated Piece Parameter.

To access special parameter settings, select the
TRANSPORT Application Context in the Document
Window Button Bar and open a Piece Window by double-
clicking the Piece icon on the Work Space or Model Space.
Then click on the S-Button for the desired parameter as
illustrated in Figure 19 below.
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Special Parameter Settings are accessed with the 
Special Parameter Settings (“S”) Buttons located 
next to each parameter in PBO Lab Piece Windows

 Double-Click Piece Icons to 
Open Individual Piece Windows

Select the TRANSPORT Application Context 
in the Document Window Button Bar

Figure 19. Opening a Special Parameter Settings Window.
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Many PBO Lab Pieces have multiple parameter sets that
can be used to specify input parameters. The different
parameter sets are accessed with a pop-up control at the
top of the Piece Window. The S-Buttons will be inactive
for parameters that are not included in the current
parameter set. For example, in the Quadrupole Piece
Window shown in Figure 19, the Quadrupole Strength
pop-up specifies the Field Gradient parameter set. Only
the three native TRANSPORT parameters for this set
(Length, Field Gradient and Roll Angle) can be selected
for special parameter settings. The native parameters are
indicated with green dots on the right edge of the Piece
Window. In order to select special settings for the Aperture
Radius parameter, the Field and Aperture parameter set
needs to be selected in the Quadrupole Strength pop-up.
Refer to the Piece Window Section in the main PBO Lab
User Manual for a description of multiple parameter sets.

The bottom half of the S-Window contains tab panels that
provide access to application-specific options for the
different PBO Lab Application Modules. Your S-Windows
will include tab panels for any installed Application
Modules. However, some Application Modules may not
support special settings for a parameter and therefore will
not have a tab panel in the S-Window.

When the TRANSPORT Application Module is installed,
there will be a Transport tab panel in the Special Parameter
Settings Window if that parameter is a native
TRANSPORT input and it is supported as a Fitting Variable
or Algebraic Expression by the TRANSPORT program.
Otherwise there will not be a Transport tab panel in the S-
Window.

Special Parameter Settings are saved with the beamline
model document. The special parameter settings for
TRANSPORT include selecting a parameter as a Fitting
Variable or defining a parameter with an Algebraic
Expression or selecting it as an Import Parameter. Refer
to the Transport Parameter Settings Section in this Chapter
for a description of the different parameter settings.

Special parameter settings will be
inactive for parameters that are not
in the selected parameter set.

Special Parameter Settings Windows
contain tab panels for the installed
PBO Lab Application Modules.

Special Parameter Settings are
available for native TRANSPORT
inputs that are supported as Fitting
Variables or Algebraic Expressions.

All of the special parameter settings
for a PBO Lab beamline model are
saved from the Document Window
with the Save or Save As commands
in the File Menu.
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Creating a copy of a Piece with special parameter settings
will also copy those settings. For example if a Piece
Parameter is defined by a user-specified Parameter Name
and that Piece is copied in the beamline, then there would
be two parameters defined by the same Parameter Name.
Both instances of the Parameter Name will be sent to
TRANSPORT but the value for the first parameter will be
used when the second parameter is encountered. This is
also true for the initial values of Fitting Variables defined
with identical Parameter Names. If there are duplicate
Fitting Variable Names then the initial value of the first
instance will be the initial value for all instances of the
Variable with the same Symbolic Name. Copying Pieces
that have Parameter Algebraic Expressions will duplicate
those expressions on the copied Piece but otherwise present
no difficulties. In some cases, it is desirable to use multiple
Pieces with parameters that are defined by the same
Parameter Name. However, if this is not the desired result,
the Parameter Name will need to be changed to a unique
name after making a copy of a Piece that includes special
parameter settings. An alternative to copying Pieces that
are to be represented with parameters that are defined with
the same special parameter settings is to create an Alias
Piece. An Alias Piece will maintain a persistent link to the
original Piece so that any changes to the original are
automatically reflected in the Alias. The Alias Piece also
supports user specified deviations from the original Piece
parameters without duplicating redundant data. Refer to
the Alias Piece Section in the main PBO Lab User Manual
for a discussion of Alias Pieces.

Copying Pieces with special
parameter settings will duplicate
Parameter Names and may result in
unintended consequences.

An alternative to copying a Piece is
to create an Alias Piece that will
maintain a persistent link with the
original Piece and will automatically
reflect any changes in the original
Piece Parameters.
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Symbolic Parameter Names
The top panel of the S-Window (Figure 20) is application-
independent and displays the Piece Comment (Label)
along with the name of the selected parameter. The
Symbolic Parameter Name input field is application-
independent and provides for a user-specified Symbolic
Parameter Name to be defined for the parameter. When
required, a default Parameter Name will be generated if a
name has not been entered in the field at the top of the S-
Window. The same Parameter Name is used for all
installed Application Modules.

The Parameter Name specified in the
top panel of the S-Window is
application-independent. The same
Parameter Name is used for all
installed Application Modules.

Using a Symbolic Parameter Name
that is identical to a Piece comment
may cause unintended results.

Application-Specific Special 
Parameter Settings for TRANSPORT 

are in the Transport tab panel

A User-Specified Symbolic 
Parameter Name is also defined in 

the top panel of the S-Window

The Application-Independent top panel of the 
S-Window displays the User Specified Piece 

Comment (Label) and the  Name of the selected 
parameter (e.g. "Magnetic-Field Gradient")

Figure 20. Special Parameter Settings Window.

A Symbolic Parameter Name is required when the parameter
is selected as a Fitting Variable or Import Parameter in the
Transport tab panel. However, Parameter Names can also be
used for defining other parameters in terms of the named
parameter even though the named parameter may not be
selected as a Fitting Variable, i.e. the parameter is treated as
a numerical constant defined by a symbolic name. When a
Parameter Name has been specified, there will be a red “S”
on the S-Button in the Piece Window and the Parameter Name
may then be used in Parameter Algebraic Expressions for
other Piece Parameters.

Parameter Names can be used in
Parameter Algebraic Expressions
specified for other Piece Parameters as
described in the Parameter Algebraic
Expressions Section of this Chapter.

Symbolic Parameter Names used in
the beamline model sould be unique.
To define multiple parameters with
the same value, define one
parameter with a unique name and
define the other parameters as
Algebraic Expressions of that name.
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Transport Parameter Settings
The Transport tab panel in the Special Parameter Settings
Window has four radio buttons for specifying the
associated parameter as: a numerical Value, a Fitting
Variable, an Algebraic Expression or an Import Parameter.
These choices are exclusive. A parameter can only be
defined by one of these special parameter settings,
although the same Symbolic Parameter Name is used for
all settings and for all Application Modules.

The first radio button in the Transport tab panel is the
default selection. It indicates that the parameter is defined
by the numerical Value entered in the Piece Window, i.e.
there are no special settings currently selected for the
parameter. The parameter may be defined with a Symbolic
Parameter Name, although it is not required for this
selection. If a Parameter Name is defined then that name
will be used to create a symbolic constant in the Transport
Input file. The parameter will be defined with that
Parameter Name and the Name may then be used to define
Algebraic Expressions for other Piece Parameters.

The second radio button in the Transport tab panel selects
the parameter as a Transport Fitting Variable using the
Symbolic Parameter Name as described in the
TRANSPORT Fitting Chapter of this Supplement.

The third radio button selects the parameter as an
Algebraic Expression. With this selection, the input field
and pop-up to the right of the radio button are activated.
The following Section describes the use of Parameter
Algebraic Expressions.

The last radio button in the Transport tab panel selects the
parameter as an Import Parameter. This selection works in
conjunction with the PBO Lab External Data Interface
Tools. The import option is not specific to TRANSPORT,
but selecting an Import Parameter excludes that parameter
as a Fitting Variable or Algebraic Expression. Refer to the
External Data Interface Section in the PBO Lab User
Manual for a description of Import Parameters.

Parameters that have been given
Symbolic Parameter Names are
defined with those Names in the
Transport Input file even when the
Parameter has not been selected as
a Fitting Variable or an Algebraic
Expression.

Refer to the Fitting Chapter in this
Supplement for a discussion of Fitting
Variables.

Refer to the following Section for a
description of Parameter Algebraic
Expressions.

Refer to the External Data Interface
Section in the main PBO Lab User
Manual for a description of the Import
Parameter special parameter setting.
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Parameter Algebraic Expressions
The TRANSPORT Application Module supports the
definition of Piece Parameters using Algebraic
Expressions. Parameter Algebraic Expressions are
specified in the Special Parameter Settings Window. To
define an Algebraic Expression for a Piece Parameter,
select the corresponding radio button in the parameters’
Special Parameter Settings Window as illustrated in Figure
21. With this selection, the input field and pop-up to the
right of the radio button are activated. An algebraic
expression is entered in the input field, which will then
be used to define the parameter in the Transport Input
file. The pop-up to the right of the input field contains a
list of all the Piece Parameters in the beamline model that
have been given Symbolic Parameter Names in addition
to Location Specific Stored Parameters. A Parameter
Algebraic Expression can be defined in terms of these
Symbolic Parameter Names as well as other
TRANSPORT program variables and symbolic constants.
Note that a Parameter Algebraic Expression is not
evaluated when it is defined in the S-Window. Algebraic
Expressions are evaluated when TRANSPORT executed.

Selecting the Algebraic Expression 
radio-button will activate the input 

field and pop-up control

A convenient pop-up is provided 
that contains all of the Named 

Parameters in the Beamline Model

Symbolic Parameter Names are not used 
for Parameter Algebraic Expressions

Figure 21. Parameter Algebraic Expressions.

Symbolic Parameter Names may be
defined for Piece Parameters, as
described in the previous Sections,
and used in Algebraic Expressions for
other Piece Parameters.

Parameter Algebraic Expressions are
not evaluated until TRANSPORT is
executed.

Symbolic Parameter Names are not
used for Piece Parameters defined
with Algebraic Expressions.
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Parameter Algebraic Expressions may be defined in terms
of user-specified Parameter Names, Fitting Variables, Stored
Parameters and may also contain TRANSPORT symbolic
constants including those listed in Table 3 below.

Table 3 TRANSPORT Symbolic Constants.

TRANSPORT Numerical
Keyword Value Units

PI 3.12159265358979323

TWOPI 2.0*PI

DEGRAD 180.0/PI

RADDEG PI/180.0

E 2.718281828459045

EMASS 0.510099906E-03 GeV

PMASS 0.93827231 GeV

CLIGHT 2.99792458E+08 m/s

MTOIN 0.0254

INTOM 1.0/MTOIN

Additional symbolic constants can be defined by the user
with the Param Piece (refer to the Parameter Piece Section
in this Chapter). User-specified Parameter Names should
not use the names that are reserved by TRANSPORT for
symbolic constants.

There are a variety of mathematical operators and functions
that can be used in Parameter Expressions. These are listed
in Table 4 with the TRANSPORT keyword or symbol.

Table 4 Operations for Algebraic Expressions.

Keyword- Operation Keyword- Operation
Symbol Symbol

+ Addition * Multiplication

- Subtraction / Division

SIN Sine COS Cosine

SINH Hyperbolic Sine COSH Hyperbolic Cosine

ASIN Inverse Sine ACOS Inverse Cosine

SQRT Square Root ALOG Natural Log

EXP Exponential

Named Piece Parameters, Fitting
Variables and Stored Parameters may
be used to define Parameter
Algebraic Expressions.

Parameter Algebraic Expressions may
include TRANSPORT symbolic
constants. Additional symbolic
constants can be defined by the user
with the Param Piece.

A variety of mathematical operators
and functions may be used in
Parameter Algebraic Expressions.
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Algebraic Expressions specified by the
user are saved even when the
parameters are not set to use the
expression.

The Parameter Named "DL1" and the 
Fitting Variable: "LD2" are used to 

define an Algebraic Expression for the 
Effective Drift Length Parameter for 

the Drift Piece labled "DRFT-3"

The Effective Drift Length Parameter 
for the Drift Piece Labeled "DRFT-1" 

has been assigned the Symbolic 
Parameter Name: "LD1"

The Drift Length Parameter for the 
Drift Piece Labeled "DRFT-2" has been 

assigned the Symbolic Parameter 
Name: "LD2" and it has been selected 

as a TRANSPORT Fitting Variable

This Pop-up provides a quick reference 
of all of the user-defined Parameter 

Names for the entire Beamline Model

Figure 22. Parameter Algebraic Expressions.

All of the special parameter settings for a PBO Lab beamline
model are saved from the Document Window using the
Save or Save As commands in the File Menu. An Algebraic
Expression for a parameter will be saved with the beamline
model document even when it is not selected in the Special
Parameter Settings Window. For example, you may define
a parameter with an Algebraic Expression and run
TRANSPORT to evaluate the expression. You could then
update the beamline model and change the special
parameter setting to use that value instead of having
TRANSPORT reevaluate the Algebraic Expression on each
execution. The expression will still be saved with the
beamline model even though it is not active.
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Figure 22 on the previous page illustrates a simple example
of a Parameter Algebraic Expression. The first S-Window
defines a Parameter Name: “LD1” for the Effective Length
of a Drift Piece. The second S-Window defines another
Drift Length parameter with the Parameter Name: “LD2”,
which is selected as a TRANSPORT Fitting Variable. The
last S-Window in Figure 22 defines one more Drift Length
Parameter as an Algebraic Expression of Named
Parameters. The value of this parameter will be calculated
by Q ANSPORT using the algebraic expression: (LD1 +
LD2) / 2.

Updating Parameter Expressions
Parameter Algebraic Expressions are evaluated when
TRANSPORT is executed. The resulting values are
presented in the PBO Lab Update Window following the
execution of TRANSPORT. The Update Window, shown
in Figure 23, provides options to individually update
selected parameters or to update all of the parameters at
once. The Update Window also contains an update panel
for any Parameters used as Fitting Variables. There are
separate Update Buttons for Variable Parameters and
Parameter Expressions in the Update Window. Both the
Variable Parameters and Parameter Expressions panels
have scroll bars to access additional entries that may not
be visible. Fitting Variables are described in Chapter 9:
TRANSPORT Fitting.

The Expression Parameters panel in the Update Window
has six columns. The user-specified Piece Label
(Comment) is in the first column, the second column
contains the name of the parameter as it appears in the
Piece Window. The third column contains the Parameter
Algebraic Expression. The Value column contains the
current numerical value of the parameter and the Update
column contains the new value computed by
TRANSPORT, which will be assigned when the parameter
is updated in the beamline model. If a parameter is not
specifically updated, then the original value will be
unchanged in the beamline model. The last column shows
the units for each parameter.

Parameter Algebraic Expressions are
evaluated when TRANSPORT is
executed. An Update Window is
automatically opened for modifying
Parameter Expression Values in the
beamline model.

Refer to Chapter 9: TRANSPORT
Fitting for an explanation of Fitting
Variables in the Update Window.

If a Parameter Algebraic Expression
is not specifically updated in the
Update Window, then the original
value will be unchanged in the
beamline model.
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Scrolling List of 
User Specified 

Fitting Variables

Scrolling List of User 
Specified  Parameter 

Algebraic Expressions

Update Only Selected 
Variable Parameters

Update All Variable 
Parameters in the List

Parameter Values 
Before and After Fitting

Evaluated Parameter 
Expressions

Click on a Parameter in the 
List to Select it for Update

Double Click a Parameter 
to Open its Piece Window

Update Any or All 
Evaluated Parameter 

Expressions

Figure 23. Parameter Update Window.

Double-clicking a parameter in the
Update Window will open the
associated Piece Window for that
parameter.

The Update Window is automatically opened after
execution of TRANSPORT. The Variables and
Expressions do not have to be updated immediately.
However, if the Update Window is closed prior to updating
any parameters then TRANSPORT will have to be run
again to access the Update Window. The Update Window
can be left open without updating parameters, in order to
examine other output results, and then parameters can be
updated in the beamline model by bringing the Update
Window to the foreground again. The Update Window
may also be used to locate the Pieces in the beamline
model with Variable Parameters or Parameter Expressions.
Double-clicking an entry in the Update Window will open
the associated Piece Window for the selected parameter.
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Parameters & Expressions
List Windows

PBO Lab provides application-specific interactive List
Windows that organize related data for the entire beamline
model. The Named Parameters List Window contains a
list of Piece Parameters that have been given Symbolic
Parameter Names. Figure 24 illustrates opening the
Named Parameters Window from the TRANSPORT
Commands Menu. The Named Parameters List Window
can be used to quickly access Named Parameters. Double-
clicking an entry in the window will open the associated
Piece Window in the beamline model.

PBO Lab provides application-specific
interactive List Windows that
organize related data for the entire
beamline model.

The Named Parameters List Window is opened 
from the TRANSPORT Commands Menu.
The List Window  contains all the Named 
Parameters for the entire beamline model

An "X" in the Fit column indicates 
that the Parameter has been selected 
as a Fitting Variable.  Clicking in 

this column toggles the Fitting 
Variable selection 

Double-clicking an entry in the 
Parameters Variables window will 
open the associated Piece window

A Param Piece can be generated for any 
selected Parameters in the List Window 

using the Create Param Piece Button

Figure 24. Named Parameters List Window.
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The header at the top of all List Windows can be used to
adjust the width of each column in the window. To resize
a column, place the mouse over the divider line in the
column header. When the arrow turns into a cross-hair,
resize by holding the mouse button down while dragging
horizontally. The List Windows themselves can also be
resized to accommodate the number of entries and desired
column widths.

Any Named Parameters that are selected as TRANSPORT
Fitting Variables are indicated with an “X” in the Fit
column of the List Window as illustrated in Figure 24.
Named Parameters can be easily selected (and unselected)
as Fitting Variables by clicking in the “Fit” column of the
List Window.

A Param Piece can be created for selected parameters in
the List Window by using the Create Param Piece Button.
To create a Param Piece, select a parameter by clicking
on the entry in the List Window. (Hold down the shift key
to select multiple parameters.) Then use the Create Param
Piece Button at the top of the window to generate a Param
Piece on the Work Space of the Document Window. PBO
Lab will automatically enter the Parameter Value in the
Param Piece and the Symbolic Parameter Name in the S-
Window for each parameter selected in the List Window.
The Param Piece is described in the Parameter Piece
Section of Chapter 3: Beamline Elements.

List windows include entries from Pieces in the Model
Space and from the Work Space. This provides quick
access to all Pieces that have special parameter settings.
Pieces on the Work Space that have special parameter
settings will also be included in the Transport Input file.
This allows Pieces in the beamline model to reference
Named Parameters from the Work Space in the definition
of Parameter Algebraic Expressions.

The header at the top of all List
Windows can be used to adjust the
width of each column in the window.

Both Parameter Variables and
Transport Fitting Variables are
contained in the Named Parameters
List Window.

A Parameter (Param) Piece can be
created for selected parameters in the
List Window by using the Create
Param Piece Button.

List windows include entries from
Pieces in the Model Space and from
the Work Space.
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A List Window is also provided for Stored Output
Parameters that have been specified with Marker Pieces
at specific locations in the beamline model. The Stored
Parameters List Window supports features that are similar
to the Named Parameters List Window and is opened from
the List Windows Submenu in the TRANSPORT
Commands Menu. Refer to the Stored Parameters List
Window sub-section in the Marker Piece Section of
Chapter 3: Beamline Elements.

PBO Lab also provides List Windows for Parameter
Algebraic Expressions and for Fitting Constraint
Expressions. These windows support the same features
as the Named Parameters and Stored Parameters List
Windows and are also accessed from the List Windows
Submenu in the TRANSPORT Commands Menu.

Figure 25 illustrates the Parameter Algebraic Expressions
and Fitting Constraint Expressions List Windows. As
with the other List Windows, the window itself, as well
as individual columns, can be resized. Double-clicking
an entry will open the associated Piece Window for
Algebraic Expressions and the associated Marker Piece
Window for Constraint Expressions. Refer to Chapter
9: TRANSPORT Fitting for further description of these
List Windows.

PBO Lab also provides a List Window
for location-specific Stored Parameters
in the beamline model. The Stored
Parameters List Window is described
in a sub-section of the Marker Piece
Section in Chapter 3: Beamline
Elements.

PBO Lab also provides List Windows
for Parameter Algebraic Expressions
and Fitting Constraint Expressions.

Double-clicking an entry in the
Parameter Algebraic Expressions List
Window will open the associated
Piece Window for that parameter.

The Fitting Constraints List Window provides 
access to all of the TRANSPORT Fitting Constraint 

Expressions for the entire beamline model

The Parameter Algebraic Expressions List 
Window provides access to all of the Parameter 

Expressions for the entire beamline model

Figure 25. Parameter Expressions and Fitting Constraints List Windows.
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5. TRANSPORT Menus
Application-specific commands are accessed from
Submenus in the PBO Lab Commands Menu and View
Menu at the top of the Document Window. When the
TRANSPORT Application Module is installed, both the
Commands Menu and the View Menu will contain
Submenus for the TRANSPORT application, in addition
to any other installed PBO Lab Application Modules. This
Chapter includes an outline of the TRANSPORT Menus,
as well as references to other Chapters in this Supplement
that provide more detailed descriptions of specific menu
commands.

TRANSPORT Commands Menu
The TRANSPORT Commands Menu is illustrated in Figure
26 and contains several options for specifying output and
executing the TRANSPORT Application Module.

Submenus for the TRANSPORT
Application Module (as well as any
other installed PBO Lab Application
Modules) are found in both the
Commands and View Menus of the
Document Window.

Separate Commands for Generating 
and Editing the Transport Input File 

and Executing TRANSPORT

Commands for Executing TRANSPORT 
and Setting Up Plot Specifications

Commands for Displaying the 
TRANSPORT R-Matrix and Sigma Matrix

Set Additional TRANSPORT 
Options and Output Parameters

Commands for Displaying User 
Named Parameters, Fitting 

Variables, Stored Parameters, 
Parameter Expressions and 

Fitting Constraint Expressions

Command for Creating a Matrix Piece 
from a beamline selection

Figure 26. PBO Lab Commands Menu for TRANSPORT Module.

The TRANSPORT Commands Menu is divided into six
groups of commands. The first group contains the two
primary commands for specifying output and running
TRANSPORT. The second group provides three additional
commands for setting up and running Transport Input files.
These are described in the following Execution
Commands Section.

The Write Input & Run Transport
command automatically creates and
executes the Transport Input file
which contains all the inputs required
by TRANSPORT.
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Execution Commands
The first command in the Commands Menu is used to run
TRANSPORT and the second command is used to specify
plot data output. The Write Input & Run Transport
Submenu provides two options that can be used to write a
Transport Input file for the beamline defined on the Model
Space and execute the TRANSPORT program.
TRANSPORT reads and executes the instructions
contained in the MAD (Methodical Accelerator Design)
formatted input file that is generated by PBO Lab. Figure
1 in the Getting Started Chapter illustrates an example
using one of these commands.

The Write Input & Run Transport Submenu includes two
options for running TRANSPORT as illustrated in Figure
27. The first includes fitting and the second excludes
fitting. The only difference between these two options is
that PBO Lab will include the FIT instruction in the native
Transport Input file for the first case and will exclude the
FIT instruction for the second case. This allows any fitting
variables and constraints that have been defined by the
user to remain part of the model, without actually having
to run the fitting procedure every time TRANSPORT is
executed. Refer to the Chapter 9: TRANSPORT Fitting
for a description of setting up and executing a
TRANSPORT fitting problem.

TRANSPORT is executed from the
Commands Menu using the Write
Input & Run Transport Command.
TRANSPORT reads and executes an
input file that is generated by PBO
Lab for the beamline in the Model
Space of the Document Window.

The Write Input & Run Transport
Command provides two options that
can be used to run TRANSPORT with
or without Fitting.

TheWrite Input & Run Transport 
Command has options for running 

TRANSPORT with or without Fitting

Figure 27. Write Input & Run Transport Submenu.
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The Transport Plot Specification command opens the
Transport Plot Specification Window, which is used to
select a variety of TRANSPORT output parameters that
will be written to the Transport Plot file. The Transport
Plot Specifications are discussed separately in the Plot
Specifications Chapter.

The second group of commands in the TRANSPORT
Commands Menu contains items to assist the user in
directly editing the Transport Input file. With these
commands, the native TRANSPORT input may be
generated from the PBO Lab beamline model without
automatically executing the TRANSPORT application.
These commands are useful for implementing
TRANSPORT instructions which may not be directly
supported by the PBO Lab user interface. Changes made
to the Transport Input file are not retained in the PBO
Lab model data and the Transport Input file will be over
written with subsequent Write Input & Run or Write Input
& View commands.

These commands can also be used to evaluate any
incompatibilities between TRANSPORT input files that
were not generated with PBO Lab. For example, an older
TRANSPORT input deck can be pasted into the Text Edit
Window that is opened with the View ‘Transport Input’ File
command. After saving the new Transport Input file with
the Save command in the Text Edit Window, this file can
then be executed with the Run ‘Transport Input’ File
command. PBO Lab will not generate a new input file when
using this command, instead the current Transport Input
file will be used to execute the TRANSPORT program.
Any incompatibilities will be noted in the Transport Output
file. The input can then be corrected before Importing the
file into PBO Lab in order to build a PBO Lab beamline
model from the native TRANSPORT deck.

Text files can also be edited by using the Open Scratch File
Command in the View Menu of the Document Window.
This command opens an empty Text Edit Window. The
Open Command in the File Menu of the Text Edit Window
can be used to open any existing text file.

The Plot Specification command is
used to set up options for different
types of graphic output and must be
set prior to running TRANSPORT.

The Transport Input file may be edited
and saved by the user. TRANSPORT
will read and execute the edited file
(errors and all!) when the Run
‘Transport Input’ File command is
selected.

PBO Lab will not generate a new
input file when using the Run
‘Transport Input’ File command.
Instead the current Transport Input
file will be used to execute the
TRANSPORT program.
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The different commands that generate the Transport Input
file and execute TRANSPORT result in a rapid data flow
which is transparent to the user. Each of these commands
involves a few well defined steps which are summarized here.

(1.) Each time they are selected, the following PBO Lab
commands write a new Transport Input file for the
beamline in the Model Space of the Document
Window, together with the Options settings, Plot
Specifications and Fitting Constraints:

Write Input & Run Transport
Write Input & View

The first command will automatically write the
input file and execute TRANSPORT. The second
command will write the input file and display it in
a Text Edit Window.

(2.) The following PBO Lab command will open the
the most recent Transport Input file without
generating new input from the beamline model:

View ‘Transport Input’ File

(3.) The following PBO Lab command executes the
most recent Transport Input file, created by either
(1.) or (2.) above:

Run ‘Transport Input’ File

The Transport Input file is not updated with any changes
made from the interface, this command simply executes
an existing Transport Input file.

Other PBO Lab commands or beamline construction tasks
may also cause a Transport Input file to be generated, thus
overwriting any existing file. For example, creating a Matrix
Piece from a selection of Pieces in the beamline model
will cause an input file to be generated, overwriting any
existing file. This input file is executed by TRANSPORT
and any existing output files are overwritten as well. All
this is transparent to the user. When the Make Matrix Piece
Command is selected, the Matrix Piece simply appears on
the Work Space of the Document Window.

When a Transport Input file is
generated, the previous input file is
overwritten.

When TRANSPORT is executed, the
previous output files are overwritten.

If the Transport Input file does not
exist, then the Run ‘Transport Input’
File command will not generate any
output.

Some of the PBO Lab commands and
beamline construction tasks may
require a Transport Input file to be
generated, thus overwriting any
existing file.
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Matrix Commands
The third and forth groups of commands in the
TRANSPORT Commands Menu contain commands for
creating and displaying matrices. The first two commands
in the third group are used for displaying the
TRANSPORT R-Matrix and Beam Sigma Matrix. The
forth group contains one command that is used to create a
Matrix Piece for a selection of beamline elements. These
commands are described separately in Chapter 6:
Displaying and Creating Matrices.

List Window Commands
The fifth group of commands in the TRANSPORT
Commands Menu contains commands for displaying user
specified Named Parameters, Parameter Expressions,
Storage Parameters, Fitting Variables and Fitting
Constraints for the entire beamline.

The List Windows Submenu provides commands to open
several PBO Lab List Windows as illustrated in Figure 28.
Each of the List Windows organize related data for all of
the Pieces in the beamline model and on the Work Space.

Commands for Creating and
Displaying Matrices are described
separately in Chapter 6 of this
Supplement.

List Windows organize related data
for all of the pieces in the beamline
model and on the Work Space.

The List Windows Sub-Menu is accessed 
from the TRANSPORT Comands Menu

Figure 28. List Windows for TRANSPORT are Accessed from the List Windows
Submenu in the TRANSPORT Commands Menu.
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List Windows are provided for Stored Parameters, Named
Parameters, Parameter Expressions and Fitting Constraint
Expressions. The Stored Parameters List Window is
described in the Marker Piece Section of the Beamline
Elements Chapter. The Named Parameters List Window
and the Parameter Expressions List Window are described
in the Parameters and Expressions List Windows Section
of the Special Parameter Settings Chapter. The Fitting
Constraint Expressions List Window is described in
Chapter 9: TRANSPORT Fitting.

Options Command
The last group in the TRANSPORT Commands Menu
contains one command. The Option Command is used to
access TRANSPORT Options for the Order of Calculation
and Output Result in addition to parameters for specifying
data to be written to the Transport output files. These
commands are discussed separately in Chapter 7:
TRANSPORT Options.

TRANSPORT View Menu
The View Menu in the Document Window contains
Submenus for any installed PBO Lab Modules. The
TRANSPORT Submenu is illustrated in Figure 29 and
contains several commands to open input, output,
diagnostic and auxiliary files for the TRANSPORT
Application Module.

TRANSPORT Input File generated by PBO Lab 
and used to execute TRANSPORT

Standard TRANSPORT Output File

Plot Data File generated by TRANSPORT 
and used by PBO Lab Graph Plot Windows

TRANSPORT Punch and Data Output Files

Submenu for Auxiliary Files

Figure 29. PBO Lab View Menu for TRANSPORT Module.

List Windows are provided for Stored
Parameters, Named Parameters,
Parameter Expressions and Fitting
Constraint Expressions.

The TRANSPORT Options Window is
described in Chapter 7: TRANSPORT
Options.

The TRANSPORT Submenu in the
View Menu of the Document
Window contains several commands
to open TRANSPORT I/O files.
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The View Menu commands do not execute TRANSPORT
or cause new I/O files to be generated. These commands
simply open the existing input, output and diagnostic files
that have already been generated from a previous
TRANSPORT run.

Each of the View Menu commands opens the associated
file in a PBO Lab Text Edit Window. These windows
provide standard editing capabilities and typical File, Edit
and Font Menus. The Save As command in the File Menu
of Text Edit Windows can be used to save any of the files
using a different name. Since these files will be overwritten
with the next execution of TRANSPORT, they should be
saved with a different name if the data is to be retained.
Renamed Text Edit Windows can remain open for
comparison with other results. However, if the file is not
renamed and the window is left open the new data from a
subsequent TRANSPORT run will overwrite the existing
data in the open window.

There are five native TRANSPORT I/O files that can be
accessed from the TRANSPORT View Submenu. These
include the standard input and output files, in addition to
the plot, punch and data files. The Transport Input file is
the native input that is generated by PBO Lab for the
beamline on the Model Space. The Transport Output file
is the main output file generated with the execution of
TRANSPORT. The Transport Plot file is the raw data
generated by TRANSPORT and plotted by PBO Lab. The
Transport Data file is an additional diagnostic output file
that is provided for PBO Lab Professional users. This file
may be used to add diagnostic write statements to the
TRANSPORT FORTRAN source code. The Transport
Punch file contains user-specified output data that is
selected in the Punch File Options tab panel in the
TRANSPORT Options Window. Refer to the Output and
Punch File Options Section in Chapter 7:
TRANSPORT Options.

The View Menu commands do not
execute TRANSPORT or cause new
I/O files to be generated.

The Save As command in the File
Menu of Text Edit Windows can be
used to save any of the files using a
different name.



The last command in the TRANSPORT View Submenu
is itself a Submenu for several Auxiliary input files that
can be generated by TRANSPORT. The Auxiliary
Submenu is illustrated in Figure 30. Table 5 lists the
different Auxiliary files that can be generated for a
beamline model. These files are not generated unless they
have been selected in the Output File Options tab panel in
the TRANSPORT Options Window. Refer to the Output
File Options Section in Chapter 7: TRANSPORT Options.
If an auxiliary file does not exist (has not been previously
generated), then an alert will be given. If an auxiliary file
has been previously generated, it will be opened with the
associated View command in a PBO Lab Text Edit
Window. Any of the Auxiliary files can be renamed with
the Save As command in the File Menu of the Text Edit
Window. Auxiliary files are named with the root name
“Auxiliary.tout”. Each file type is then given its’ own
extension which is appended to the root name. If a file of
the same name exists when a new file is generated, then it
will be overwritten with the new file.

Table 5. Auxiliary Files Generated by TRANSPORT

Keyword Description
MAD Methodical Accelerator Definition Input File
TRANSPORT TRANSPORT Input File
LATDEF Lattice Definition Input File
STRUCT STRUCT Input File
ACAD Autocad Input File

The Auxiliary Files Submenu contains
commands to view several Auxiliary
input files that can be generated by
TRANSPORT. These files are not
generated unless they have been
selected in the Output File Options
tab panel in the TRANSPORT Options
Window. Refer to the Output File
Options Section in Chapter 7:
TRANSPORT Options.

The Auxiliary Submenu provides commands 
to open several Auxiliary files after they 

have been generated by TRANSPORT

Figure 30. View Menu Commands to Open Auxiliary Files.
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6. Displaying and Creating Matrices
There are three commands in the TRANSPORT
Commands Menu that are used for displaying and creating
matrices. These commands are separated into two groups.
The first group has two commands for displaying matrix
data from the last execution of TRANSPORT. The second
group contains one command that is used to execute
TRANSPORT in order to create a Matrix Piece for a
selection of beamline elements in the Model Space of the
Document Window.

Show R-Matrix
The Show R-Matrix Command in the TRANSPORT
Commands Menu opens the R-Matrix Window shown in
Figure 31. This R-Matrix Window displays the transfer
R-Matrix data at the end of the beamline for the last
TRANSPORT run executed. No specific options settings
are required to generate the data for the R-Matrix Window.
However, the Show R-Matrix command will be inactive
if TRANSPORT has not been executed.

Creating a Matrix Piece
The Create Matrix Piece button in the Button Bar of the
R-Matrix Window is used to generate a Matrix Piece from
the R-Matrix data. The Matrix Piece is created on the Work
Space of the Document Window as illustrated in Figure
31. The Matrix Piece represents the entire beamline model
from the previous TRANSPORT execution that was
displayed in the R-Matrix Window and may be used in
place of the individual beamline elements. This may speed
up calculations for very large models that have particular
sections where the parameters are fixed so that Matrix
Pieces can be generated and used to replace the individual
beamline elements.

The Show R-Matrix Command
displays the R-Matrix for the last
execution of TRANSPORT.

An unlimited number of R-Matrix
Windows may be left open for
comparing results from multiple
TRANSPORT runs.

Matrix Pieces may be used in a
beamline model to replace entire
beamline segments with a single R-
Matrix representation for that
segment.

The Output File Option in the
TRANSPORT Options Window that
causes TRANSPORT to generate the
transverse matrix components in
millimeters and milliradians does not
effect the R-Matrix Window, which
will always display the matrix data in
meters and inverse meters.

PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

61



PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

62

The Show R-Matrix Command Opens 
the Transport R-Matrix Window

The Create Matrix Piece Button 
Generates a Matrix Piece on the Work 

Space for the Current R-Matrix

The Matrix Piece may be Inserted 
into the Beamline Model by 

Dragging it to the Model Space

Double Click the Matrix Piece 
to Open the Piece Window

Figure 31. Creating a Matrix Piece from the Transport R-Matrix Window.
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Show Sigma Matrix
The Show Sigma Matrix Command in the TRANSPORT
Commands Menu opens the Output Sigma-Matrix
Window as illustrated in Figure 32. This window displays
the Output Sigma-Matrix (Beam Matrix) at the end of the
beamline from the last TRANSPORT run executed.

There are no specific option settings required to generate
the data for the Sigma-Matrix Window. However, the
Show Sigma-Matrix Command will be inactive if
TRANSPORT has not been executed. An unlimited
number of Matrix Windows may be left open for
comparing results from multiple TRANSPORT runs.

There are two panels in the Output Sigma-Matrix Window.
The top panel shows the TRANSPORT Reduced Sigma-
Matrix and the bottom panel shows the full Output Sigma-
Matrix in units of meters and radians. The first column of
the Reduced Sigma-Matrix display, labeled: Diagonal,
represents the half widths of the beam ellipsoid in each of
the six beam coordinates. The remaining elements
represent the correlation coefficients between coordinates.

Creating a Beam Piece
The Button Bar at the top of the Sigma-Matrix Window
provides an option for creating a PBO Lab Beam Piece
from the TRANSPORT Output Sigma-Matrix data. The
Create Beam Piece button will generate a new Beam Piece
and place it on the Work Space of the Document Window
as illustrated in Figure 32. The Beam Piece Parameters
will be generated for the Sigma Matrix data and Phase
Space Ellipse Plots will be displayed in the Beam Piece
Window. The Beam Piece can be used in the beamline
model or simply left on the Work Space for comparison
with subsequent TRANSPORT runs.

The Show Sigma-Matrix Command
displays the Sigma-Matrix for the last
execution of TRANSPORT.

Refer to the “TRANSPORT User
Manual” for a description of the
Sigma Matrix and Reduced Sigma
Matrix formulation.

The Sigma-Matrix Window provides
a button for creating a PBO Lab Beam
Piece from the TRANSPORT Output
Sigma-Matrix data.
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The Show Sigma Matrix Command 
Opens the Transport Output 

Sigma-Matrix Window

The Create Beam Piece Button 
Generates a Beam Piece on the Work 

Space for the Current Output 
Sigma-Matrix

Double Click the Beam Piece to 
Open the Piece Window

Figure 32. Creating a Beam Piece from the Output Sigma Matrix Window.
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Make Matrix Piece Command
The Make Matrix Piece Command is used to create a
Matrix Piece for a selection of pieces in the beamline
model. Using a single Matrix Piece to replace a static
beamline segment that contains many pieces can
significantly speed up calculations for large models. This
command is similar to using the Create Matrix Piece
button in the Show R-Matrix Window. However, this
command operates on a selection of pieces in the beamline
model, unlike the R-Matrix Window button, which always
creates a Matrix Piece for the entire beamline. The Make
Matrix Piece Command in the Commands Menu is also
different because TRANSPORT is automatically executed
to compute the R-Matrix for the beamline model selection.
When creating a Matrix Piece from the Show R-Matrix
Window, the R-Matrix data from the last TRANSPORT
execution is always used. Refer to the Show R-Matrix
Section in this Chapter.

To create a Matrix Piece with the Make Matrix Piece
Command, first make a selection of pieces in the beamline
model and then select the Make Matrix Piece Command in
the TRANSPORT Commands Menu. TRANSPORT will be
executed to calculate the R-Matrix for the beamline selection.
A Matrix Piece will automatically be generated and placed
in the lower left corner of the Work Space as illustrated in
Figure 33. The Matrix Piece can then be used to replace the
original beamline selection in the Model Space.

The original selection of pieces in the beamline model
that are used to create the Matrix Piece are not changed
or replaced automatically. Drag a copy of the original
selection to the Work Space before deleting these pieces
in the beamline because they can not be re-generated from
the corresponding Matrix Piece. The Matrix Piece can
then be placed in the beamline at the location of the
original pieces. This command can also be used to generate
an R-Matrix through a specific location in the beamline
model for comparison with other results.

The Create Matrix Piece Command
is used to create a Matrix Piece for a
selection of pieces in the beamline
model.

A Matrix Piece can also be created
for the entire beamline model from
the R-Matrix Window.  Refer to the
Show R-Matrix Section in this
Chapter.

To create a Matrix Piece first make a
selection of pieces in the beamline
model and then select the Make
Matrix Piece Command in the
TRANSPORT Commands Menu.

The original selection of pieces in the
beamline model that are used to
create a Matrix Piece are not
modified. The Matrix Piece will
appear on the Work Space and can
then be used to replace the original
selection in the beamline model.
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The Make Matrix Piece Command generates a 
Matrix Piece for the beamline model selection and 
places it in the lower left corner of the Work Space

Drag a copy of the Matrix Piece from the Work 
Space and replace the original selection of pieces 

in the beamline model

Drag a copy of the beamline model selection to the 
Work Space prior to replacing it in the beamline 

with the new Matrix Piece

(Use the View Menu Command or the Button Bar 
control to Hide/Show the Global Parameters panel)

Make a selection of Pieces in the beamline 
model and use the Make Matrix Piece Command 
to generate a Matrix Piece on the Work Space 

for the beamline selection

Figure 33. Creating a Matrix Piece for a Beamline Selection.
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PBO Lab provides an Output File Option in the
TRANSPORT Options Window that causes
TRANSPORT to generate the transverse matrix
components in millimeters and milliradians. This mixed
units representation will only appear in the Transport Output
File when this option is selected. The Matrix Piece Window
will always display the matrix data in meters and inverse
meters regardless of the TRANSPORT Output File Option.

The Matrix Piece Window is described in more detail in
the Matrix Piece Section of Chapter 3: Beamline Elements.

The Matrix Piece Window displays the
transfer matrices in units of meters,
radians and inverse meters, radians
regardless of units selection for the
Output File in the TRANSPORT
Options Window.



PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

68

This page is intentionally blank.



P
B

O
 L

ab
T

M

 2
.0

P
B

O
 L

ab
T

M

 2
.0

TRANSPORT Options

User Manual
Supplement:
TRANSPORT
Application
Module

User Manual
Supplement:
TRANSPORT
Application
Module

69



70



7. TRANSPORT Options
PBO Lab provides several options for specifying
parameters which direct TRANSPORT to write data to
the Output and Punch files. TRANSPORT options also
include parameters for setting the Calculation Order and
Output Result for TRANSPORT runs. The Options
Window is accessed with the last item in the TRANSPORT
Commands menu as illustrated in Figure 34.

All of the TRANSPORT Options are
saved with the beamline model in the
Document Window when a Save, or
a Save As command is executed.

The TRANSPORT Options Window is 
Opened from the Commands Menu

Figure 34. Opening the TRANSPORT Options Window.

TRANSPORT Options are presented in a single window
with multiple tab panels for (1) calculation order and
output result, (2) printing matrices after every beamline
element, (3) printing matrices after the last element, (4)
various format options for the Transport Output file, and
(5) printing matrices to the Transport Punch file. All of
the TRANSPORT Options are saved with the model file
using the Save or Save As commands in the File Menu.

TRANSPORT output may also be
specified at specific locations in the
beamline using Marker Pieces as
described in the previous Section.
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Calculation Order & Output Result
The TRANSPORT Application Module integrated with
PBO Lab can model optics problems up to the third order.
The first tab panel in the TRANSPORT Options Window
illustrated in Figure 35, is used to set up the Calculation
Order and the Output Result matrices for TRANSPORT.

The Calculation Order represents the order to which the
transfer matrices are calculated about the reference
trajectory. Calculating to Zero Order simply traces the
beam centroid through the beamline elements. Tracing
the beam centroid has meaning only when the beam
centroid is displaced from the reference trajectory with a
Centroid Piece after the Beam Piece in the beamline
model. The Output Result selection determines the Order
of the transfer matrix to be written to the Transport Output
and Transport Punch files.

Figure 35. Calculation Order and the Output Result.

The Order of the Output Result can not be higher then the
Order of Calculation. Output Result options higher than
the specified Calculation Order will be inactive.

The TRANSPORT Calculation Order
and Output Result are set in the
TRANSPORT Options Window.

The order of the Output Result can
not be higher then the Calculation
Order.

The options in the Order of
Calculation Window are saved with
the Document using the Save or Save
As commands.
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The Calculation Order tab panel also includes a check
box to specify the use of a second-order path length
difference correction. This second-order path length
correction option corrects a long standing calculation error
in TRANSPORT that has only recently been identified.
The error involves the second-order path length difference
for beamlines that use radiofrequency (RF) accelerator
elements. The second-order path length option corrects
this historical error in TRANSPORT. Transverse results
for magnetic systems will be identical to the original
TRANSPORT. However, for beamlines with
RF accelerator elements the new path length correction
will change (correctly) the second-order transverse results.

Print Options
The tab panels illustrated in Figure 36 may be used to
specify Print Options at the end of the beamline model or
after every piece in the model. However, it is also possible
to specify output at specific locations in the beamline using
the Marker or Final Pieces.

This correction only applies to the
second-order path length with
second or third-order calculations.
The path length correction is on by
default.

The Marker and Final Pieces may be
used to specify output at specific
locations in the beamline. Refer to
the Marker Piece Section in the
Beamline Elements Chapter.

Output Options may be Specified After each 
Piece or at the End of the Beam Line Model

Marker or Final Pieces Could be Inserted 
in the Beam Line to Request the Same 

Output at Specific Locations or at the End 
of the Beam Line Model

Figure 36. Specifying Output after every Piece or at the end of the Model.
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Output and Punch File Options
The TRANSPORT Options Window is also used to set up
several parameters for specifying and formatting data to be
written to the Transport Output file and to the Transport
Punch file. In addition, the Output File Options tab panel
includes several options for generating Auxiliary files.

The Output File Options tab panel, shown in Figure 37,
includes two options panels, one for Transport Output File
Options and another for selecting among a variety of
Auxiliary Files that can be generated from TRANSPORT.
The File Options panel provides selections that effect the
content and format of the Transport Output file. The
Transport Output file is the native text file generated by
TRANSPORT and displayed by PBO Lab automatically
after TRANSPORT is executed. The options provided are
those most frequently encountered by TRANSPORT users.
Note that the Output File Options effect the Transport
Output file only, not other PBO Lab display windows.

The Output File Options tab panel includes 
various content and format options for the 

Transport Output File and selections for 
generating a variety of Auxiliary Files

Figure 37. TRANSPORT Output File Options and Auxiliary Files.

The Auxiliry Files panel includes several different input
files that can be generated by TRANSPORT for the
beamline model in the Document Window.
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The different Auxiliary files that can be generated include:
(1) Methodical Accelerator Definition (MAD) input file,
(2) TRANSPORT input file (created by TRANSPORT,
not PBO Lab), (3) Latice Definition (LATDEF) input file,
(4) STRUCT input file, and (5) Autocad input file. These
files will be generated when TRANSPORT is executed
for the corresponding selections in the Auxiliary Files
panel. Once these files are generated, they can be viewed
in Text Edit Windows using the PBO Lab View Menu
commands in the Document Window. Refer to the
TRANSPORT View Menu Section in Chapter 5:
TRANSPORT Menus. All of the files use “Auxiliary.tout”
as a root name with their own extensions appended to the
end. For example if the MAD option is selected, a file
named “Auxiliary.tout.mad” will be generated. If a file of
the same name exists when a new file is generated then it
will be overwritten with the new file.

The Punch File Options tab panel, shown in Figure 38,
provides options for writing transfer matrices to the
Transport Punch file. The Punch file is a secondary data
file generated by TRANSPORT that can be viewed in Text
Edit Windows using the PBO Lab View Menu commands
for TRANSPORT. As with the other TRANSPORT I/O
files, the data will be overwritten each time TRANSPORT is
executed. You can save previously generated output by using
the Save As command in the File Menu of the Text Edit
Windows used to view the files.

Refer to the “TRANSPORT User
Manual” for a description of the
Auxiliary files that can be generated.

The Punch File Options tab panel
provides options for writing transfer
matrices to the Transport Punch file.

Additional output can be directed to 
the Transport Punch file from the 

Punch File Options tab panel

Figure 38. TRANSPORT Punch File Options.
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8. TRANSPORT Plot Specifications
The Transport Plot Specification Window is used to define
the type of plot data that will be generated by
TRANSPORT and the Graph Plot Window that will be
displayed by PBO Lab after TRANSPORT is executed.
Figure 39 shows the window that is brought up when the
Transport Plot Specification Command is selected in
TRANSPORT Commands Menu.

Any Plot Specifications will be saved
with the beamline model when the
Save, or Save As, command is
selected in the Document Window.

The Transport Plot Specification 
Window is Opened from the 

TRANSPORT Commands Menu

Figure 39. Opening the Transport Plot Specification Window.

The Plot Specification Window is used to set up a variety
of different graphic output plots. TRANSPORT can only
generate data for one plot type in a given run, so one of
the available plot types must be selected using the radio
buttons in the Plot Selection panel in the upper left corner
of the window. Four plot types are available: (1) Matrix
Elements vs. Length, (2) Envelope, Centroid and Lattice
functions vs. Length, (3) Floor Plots, (4) Final Ellipse
Plots, or No Plots.
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The Matrix Elements vs. Length selection uses the matrix
controls to select specific matrix elements (Figure 40). The
Envelope, Centroid and Lattice functions vs. Length panel
is used when the Plot Selection is set for this plot type. The
Floor Plot type has an adjacent pop-up to specify Side View
or Top View. The Final Ellipse Plot type and No Plot
selections require no additional user input. The last panel
in the lower right corner of the Plot Specifications Window
is used to select up to four different plot variables for both
the Matrix Elements vs. Length and Envelope, Centroid
and Lattice functions vs. Length plot types.

In order to activate the Plot Selections
panel so a different plot type can be
selected, all plot variables for the
current plot type must be cleared
with the Delete All button.

S11
S12
S33
S34

Matrix Elements 
vs. Length Panel -

Select the desired matrix, Beam, 
Sigma, etc. then pick the desired 
element in the matrix panel, use 
the Set Button to add the element 

to the Plot Variables list

Envelope, Centroid and Lattice Functions
vs. Length Panel -

Select up to four Plot Variables from the different Envelope, 
Centroid and Lattice Function pop-ups in this panel, use the Set 

Button to add the selection to the Plot Variables list

Plot Selection Panel -

Select the Desired Plot Type
Any Previously Selected Plot 

Variables Must be Deleted 
Before Changing the Plot Type 

(Use the Delete All Button)

Plot Variables Panel -

Selected Plot Variables for a Matrix 
Elements vs. Length Plot or for  an 

Envelope, Centroid and Lattice 
Functions vs. Length Plot

(Use the Set Button to add a plot 
variable for the current Plot Selection)

The Graph Plot Window is 
Automatically Opened Following 

the Execution of TRANSPORT 

Four Beam Matrix 
Elements are Set as 
Plot Variables  for a 
Matrix Elements vs. 
Length Graph Plot

Figure 40. Transport Plot Specifications Window.
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Clicking in a cell of the matrix table
will highlight that cell and the
selection can then be added using the
Set button.

The last plot type in the Plot Selection panel is for no
plots. This is the default plot type. When a new untitled
Document is created the No Plots option is selected. Plot
data will not be generated and a Graph Plot window will
not be opened following the execution of TRANSPORT.

The following Sections describe each of the Plot
Selections types separately. A description of the different
features available in the PBO Lab Graph Plot Windows
can be found in the main PBO Lab User Manual. The
TRANSPORT keywords that are used to generate plot data
are listed in Table 6.

Plotting Matrix Elements vs. Length
When choosing to plot Matrix Elements vs. Length, as
many as four different matrix elements may be selected
for an individual Graph Plot. The Matrix elements may
be selected from: (a) Rij, First-Order Transfer Matrix, (b)
RAij, Auxiliary First-Order Transfer Matrix, (c) Tijk ,
Second-Order Transfer Matrix, (d) TAijk , Auxiliary
Second-Order Transfer Matrix, (e) Uijkl , Third-Order
Transfer Matrix, (f) UAijkl , Auxiliary Third-Order Transfer
Matrix, (g) Beam Matrix, and (h) Correlation Matrix. The
Matrix Elements panel in the lower left corner of the Plot
Specification Window is active only when the Matrix
Elements vs. Length radio button is selected in the Plot
Selection panel (Figure 40).

To select a matrix element, first chose the radio button in
the Matrix Elements vs. Length panel for the desired
transfer matrix: R-Matrix, T-Matrix, U-Matrix, Beam
Matrix or Correlation Matrix. The R and T Matrix
selections also provide a pop-up to select between the
Regular Matrix or the Auxiliary Matrix. The T-Matrix
selection requires an additional selection to specify the i
index, and the U-Matrix requires both i and j indices to
be specified. This is done with the pop-ups to the right of
the Matrix radio buttons. The 6x6 matrix table at the
bottom of the Matrix Elements panel is then used to select
individual matrix elements.
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Clicking in a cell of the matrix table will highlight that cell
and the selection can then be added using the Set button.
After a selection is made, the corresponding TRANSPORT
keyword (Table 6) will appear in the plot variable list in the
lower right corner of the Plot Specification Window (Figure
40). Selections can also be removed from the list; first
highlight the item to be removed by clicking on it, then
press the Delete button. The Delete All button clears all
plot variables from the list.

Table 6. TRANSPORT Keywords.

Beam & Correlation: Beam Correlation

i, j, k & l = 1,6 S ij Cij

Transfer Matrices: Regular Auxiliary

First-Order Rij RAij

Second-Order Tijk TAijk

Third-Order Uijkl UAijkl

Beam Envelopes: Half Width Half Angle

Horizontal XBEAM XPBEAM

Vertical YBEAM YPBEAM

Longitudinal LBEAM DELBEAM

Beam Centroids: Position Angle

Horizontal XC XPC

Vertical YC YPC

Longitudinal DLC DELC

Lattice Functions: Horizontal Vertical

βx βy BETAX BETAY

αx αy ALPHAX ALPHAY

ηx ηy ETAX ETAY

η,x η,y DETAX DETAY

Plotting Envelope, Centroid and Lattice
Functions vs. Accumulated Length

The Envelope, Centroid and Lattice Functions vs. Length
panel in the upper right corner of the Plot Specification
Window is active only when the corresponding radio
button is selected in the Plot Selection panel.

Table 6 shows the TRANSPORT
Keywords that can be used for Plot
Specifications.

When a plot selection is made,
the TRANSPORT keyword will appear
in the Plot Variable panel in the lower
right corner of the Plot Specification
Window.
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Only one of the three options (Envelopes, Centroids or
Lattice Functions) can be chosen at a time. First select
one of the radio buttons and then make a selection from
the corresponding pop-up (Figure 41). Up to four
selections can be set for a given option by choosing the
desired pop-up item and pressing the Set button. Use the
Delete or Delete All buttons to removed a selected variable
or clear all the plot variables from the list.

This Graph Plot shows the Accelerator Functions         
(ALPHAY),          (BETAY),         (ALPHAX) and        (BETAX) 
plotted as a function of the Accumulated Beam Line Length

βxβy α x

α y

This Graph Plot shows the Horizontal Beam Half 
Width (XBEAM), Horizontal Beam Half Angle 

(XPBEAM), Vertical Beam Half Width (YBEAM) and 
Vertical Beam Half Angle (YPBEAM) plotted as a 

function of Accumulated Beam Line Length

This Graph Plot shows the Horizontal Beam Centroid Position 
(XC), Horizontal Beam Centroid Angle (XPC), Vertical Beam 
Centroid Position (YC), Vertical Beam Centroid Angle (YPC) 

plotted as a function of Accumulated Beam Line Length

Figure 41. Beam Envelopes, Beam Centroids and Lattice Functions.

This Graph Plot shows the Horizontal Beam Half
Width (XBEAM), Horizontal Beam Half Angle

(XPBEAM), Vertical Beam Half Width (YBEAM) and
Vertical Beam Half Angle (YPBEAM) plotted as a

function of Accumulated Beam Line Length

This Graph Plot shows the Accelerator Functions αy

(ALPHAY), βy (BETAY), αx (ALPHAX) and βx (BETAX)
plotted as a function of the Accumulated Beam Line Length



Plotting Floor Coordinates
This plot type is used to generate top and side view Graph
Plots for floor coordinates of the reference trajectory. The
pop-up to the right of the Floor Coordinates radio button
is used to select between top and side views. There is no
additional input required in the Plot Specification Window.
However, included with the Global Parameters in the
Document Window are a set of Initial Floor Coordinate
Parameters (Figure 4). These are used to specify the initial
coordinates and the orientation of the reference trajectory
for plotting floor coordinates.

Plotting Final Ellipses
This plot type is used to generate horizontal and vertical
Transverse Phase Space Ellipse Plots for the end of the
beamline. There are no additional inputs required for this
plot type, simply choose the Final Ellipse Plots radio
button in the Plot Selection panel (Figure 39). A Final
Ellipse Graph Plot Window (Figure 42) will be opened
automatically after running TRANSPORT.

Example of a Phase Space Ellipse 
Plot (XP vs. X and YP vs. Y)

Figure 42. Phase Space Ellipse Plot.

Graph Plot Windows
The selected Transport Plot Specification will be
automatically generated in a PBO Lab Graph Plot Window
after TRANSPORT is executed. The Graph Plot Windows
provide a variety of interactive features which are
described in the PBO Lab User Manual. Refer to the Graph
Plot Windows Section in the Analysis Tools Chapter of
the main PBO Lab User Manual.

Floor plots can also be generated
using the PBO Lab Tools for Focusing
and Bending Trajectories in the Tools
Menu.

You may need to clear previously
selected plot variables with the Delete
All button, in order to activate the
Plot Selection radio buttons.

A Graph Plot window is automatically
opened, for the Transport Plot
Specifications selected when the Write
Input & Run Transport command is
issued.
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9. TRANSPORT Fitting
The TRANSPORT program can be used to find solutions
for a wide of variety of beamline fitting problems. Fitting
problems are formulated in terms of constraints and
variables. Selected beamline element parameters are
varied in an effort to satisfy (“fit”) the constraints. Fitting
constraints are algebraic expressions defined in terms of
user-specified Named Parameters and Fitting Variables
in the beamline model as well as a number of different
TRANSPORT output parameters.

PBO Lab provides a drag & drop - point & click user
interface for setting up and running a TRANSPORT fitting
problem. Fitting Constraints are specified in user friendly
windows accessed from Marker or Final Pieces that can
be inserted anywhere in the beamline model. Parameter
Variables are specified in Special Parameter Settings
Windows accessed from any Piece Window. Interactive
List Windows that organize all of the Fitting Variables
and Constraints for the entire beamline model are accessed
from the TRANSPORT Commands Menu. Fitting
Variables can be examined after fitting and the beamline
model can be updated with any or all of the fit values in
the Update Window which is opened automatically
following the fit procedure.

A Symbolic Parameter Name may be defined for a Piece
Parameter without using it as a Fitting Variable. These
Named Parameters may then be used to define Parameter
Algebraic Expressions for other Piece Parameters.
Parameter Expressions can also be specified in terms of
user-defined Fitting Variables and TRANSPORT program
variables. Refer to chapter 4: Special Parameter Settings,
for a description of Symbolic Parameter Names, Parameter
Expressions and selecting a Parameter as a Fitting Variable.

This Chapter describes the user interface for setting up a
TRANSPORT fitting problem. The “TRANSPORT User
Manual” describes specific fitting capabilities of the
program in more detail.

Fitting problems are formulated in
terms of fitting constraints and
variables. Selected beamline model
parameters are varied in an effort to
satisfy (“fit”) the constraints.

Fitting Constraints can be specified
with Marker or Final Pieces that can
be inserted anywhere in the beamline
model.

Interactive List Windows provide
quick access to all of the user-
specified Variables, Expressions and
Constraints for the entire beamline
model.

A Symbolic Parameter Name may be
defined for a Piece Parameter without
using it as a Fitting Variable.

Parameter Algebraic Expressions may
be defined in terms of user-specified
Named Parameters and/or Fitting
Variables.

Refer to the Special Parameter
Settings Section in Chapter 4 of this
Supplement.
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Fitting Variables
Many of the input parameters for the various beamline
elements can be selected by the user as TRANSPORT
Fitting Variables. Fitting Variables are selected in Special
Parameter Settings Windows that are opened with the
Special (“S”) button to the left of most parameters in PBO
Lab Piece Windows. Figure 43 illustrates selecting the
Magnetic-Field Gradient parameter in a Quadrupole Piece
Window; pressing the “S” button opens the Special
Parameter Settings Window for the associated parameter.
The second radio button in the TRANSPORT tab panel
of the S-Window, selects the parameter as a TRANSPORT
Fitting Variable using the Parameter Name specified at
the top of the window.

Fitting Variables are selected in
Special Parameter Settings windows
that are opened with the Special (“S”)
button to the left of most parameters
in PBO Lab Piece Windows.

A Fitting Variable that has a Symbolic
Parameter Name identical to a Piece
Comment will also result in the first
parameter (regardless of name) for
that Piece to be varied.

Special Parameter Settings are accessed with the 
Special Parameter Settings (“S”) Buttons located 
next to each parameter in PBO Lab Piece Windows

 Double-Click Piece Icons to 
Open Individual Piece Windows

Select the TRANSPORT Application Context 
in the Document Window Button Bar

Figure 43. Opening a Special Parameter Settings Window.



PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

89

Transport Fitting Variables must be native inputs to
TRANSPORT in order to be varied during fitting. Green
dots appear next to “native” TRANSPORT parameters in
Piece Windows when the Application Context is set for
TRANSPORT as illustrated in Figure 43. The S-Buttons
will be inactive for those parameters without green dots.
Native (green dot) parameters that do not support special
parameter settings will not have a Transport tab panel in
the Special Parameter Settings Window.

Many PBO Lab Pieces provide alternative parameter sets
for specifying inputs for TRANSPORT. For example the
Quadrupole Piece illustrated in Figure 43 can be defined
in terms of three different parameter sets (selected with
the Quadrupole Strength pop-up at the top of the Quad
Piece Window). Depending on the users preferred set,
different Piece Parameters will be used as native inputs to
TRANSPORT. The green dots next to native parameters
will reflect the current parameter set and only those
parameters will be used as TRANSPORT inputs for the
Piece. A Fitting Variable previously defined for a different
parameter set will have no effect. For example, both the
Magnetic Field at Pole Tip and the Magnetic-Field
Gradient parameters could be selected as Fitting Variables
by switching the Quadrupole Strength selection. However,
only one of these parameters will be used as input for
TRANSPORT (according to the current Quadrupole
Strength selection), so the other will not be an input for
the Quad and will not be varied during fitting.

The example illustrated in Figure 43 shows the Magnetic-
Field Gradient defined by the Symbolic Parameter Name
“VARY4”. This parameter has been selected as a Fitting
Variable in the Transport tab panel of the S-Window.
Fitting Variables are always defined by the application-
independent Symbolic Parameter Name specified in the
S-Window. If a name has not been specified it will be
generated when the Fitting Variable selection is made in
the TRANSPORT tab panel.

Some (but not all) Piece Parameters
may be selected as Fitting Variables
and used by TRANSPORT to fit user-
specified Constraint Expressions.

TRANSPORT supports up to twenty
(20) independent user-specified
Fitting Variables.

The green dots next to Piece
Parameters reflect the current
Application Context and the users
parameter set selection. Only green
dot parameters will be used as
TRANSPORT input for the Piece.

All special parameter settings are
saved with the beamline model when
using a Save, or Save As, command.



PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

90

The Symbolic Parameter Names can also be used in
Algebraic Expressions specified for other Piece
parameters as described in the Parameter Algebraic
Expressions Section of Chapter 4: Special Parameter
Settings. During a fitting procedure, Algebraic Parameter
Expressions are evaluated at each iteration. After fitting
has completed, the new values for all of the Fitting
Variables and Parameter Algebraic Expressions can be
used to update the beamline model.

Alias Pieces can also be used to couple multiple beamline
elements during a fitting procedure. Refer to the Aliases
Section in the User Interface Chapter of the main PBO Lab
User Manual, for a description of Alias Pieces.

Creating a copy of a Piece with Special Parameter Settings
will also copy those settings. For example if a Piece
Parameter has been selected as a Fitting Variable and that
Piece is copied in the beamline, then there would be two
parameters defined by the same Parameter Name. Both
instances of the Parameter Variable will be sent to
TRANSPORT but the initial value for the first Fitting
Variable encountered will be used for any other Variables
in the beamline that have the same Parameter Name.
Copying Pieces that have Parameter Algebraic
Expressions will duplicate those expressions on the copied
Piece but otherwise present no difficulties.

A Piece with a Comment that is the same as any Symbolic
Parameter Name selected as a Fitting Variable can cause
the first parameter of that Piece to be varied. This may be
unintended. To avoid this, make sure that no Symbolic
Parameter is used as a Piece Comment.

A Parameter Name may be defined
for use in an Parameter Algebraic
Expression without selecting the
Parameter as a Fitting Variable.

A Piece Parameter may be varied or
it may be defined by an expression,
but not both.

Alias Pieces can also be used to
couple multiple beamline elements
for a fitting problem.

Creating a copy of a Piece with
Special Parameter Settings, either
with the cut/copy/paste commands
or by simply dragging a copy to the
work space, will also copy the Special
Parameter Settings from the original
Piece to the duplicate.

Using a Symbolic Parameter Name
that is identical to a Piece comment
may cause unintended results.



PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

91

Named Parameters List Window
All of the Piece Parameters in the beamline model and on
the Work Space that have been given Symbolic Parameter
Names will be listed in the Named Parameter List Window.
Named Parameters that are selected as Fitting Variables are
indicated with an “X” in the Fit column of the Named
Parameters List Window as illustrated in Figure 44.

Any Parameter with a Symbolic
Parameter Name will be included in
the Named Parameters List Window.
Fitting Variables are indicated with an
“X” in the Fit column of the Named
Parameters List Window.

The Named Parameters List Window is opened 
from the TRANSPORT Commands Menu.
The List Window  contains all the Named 
Parameters for the entire beamline model

An "X" in the Fit column indicates 
that the Parameter has been selected 
as a Fitting Variable.  Clicking in 

this column toggles the Fitting 
Variable selection 

Double-clicking an entry in the 
Parameters Variables window will 
open the associated Piece window

A Param Piece can be generated for any 
selected Parameters in the List Window 

using the Create Param Piece Button

Figure 44. Named Parameters List Window.

Named Parameters can be easily selected (and unselected)
as Fitting Variables by clicking in the “Fit” column of the
List Window. A Param Piece can be created for selected
parameters in the List Window by using the Create Param
Piece Button. Refer to the Parameters and Expressions List
Windows Section in Chapter 4: Special Parameter Settings.

Refer to the Parameters and
Expressions List Windows Section in
Chapter 4: Special Parameter Settings.
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Fitting Constraints
TRANSPORT Fitting Constraints are defined as location-
specific algebraic expressions of user-specified Named
Parameters and Fitting Variables, as well as a variety of
TRANSPORT output parameters. Multiple Fitting
Constraint Expressions may be defined for different
locations in the beamline model.

Fitting Constraints are defined at user-specified locations
in the beamline model using Marker or Final Pieces. Drag
a Marker or Final Piece from the Palette Bar and insert it
at the desired location in the beamline model. Open the
Marker Piece Window by double-clicking the Piece icon
as illustrated in Figure 45.

    

Marker and Final Pieces

The Marker and Final Pieces are used
to define application-specific Fitting
Constraints and Diagnostics at
specific beamline locations.

Open a TRANSPORT 
Fitting ConstraintsWindow

TRANSPORT 
Application Context

The Marker Piece is used to Specify 
Application-Specific Constraints and 

Diagnostics at the Location of the 
Marker Piece in the Beamline Model

Figure 45. Marker and Final Pieces are used to mark locations
in the beamline for specifying TRANSPORT Fitting Constraints.
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A Marker Piece is used to define application-specific
Constraints, Diagnostics and Stored Parameters that are
dependent on a specific location in the beamline model.
A Marker Piece can be used by all installed Application
Modules and therefore depends on the current Application
Context. The Application Context can be changed in the
Document Window or directly in the Marker Piece
Window as illustrated in Figure 46. Refer to the Marker
Piece Section in Chapter 3:Beamline Elements for a
description of using the Marker and Final Pieces.

The Constraints panel of the Marker Piece Window contains
a list of all the specified Constraint Expressions for this
location in the beamline. Each entry is preceded by the
Application Module name. Making a selection in this list
and pressing the Remove button will delete that entry from
the list without having to open the Constraints Window.

The Open buttons in the Marker
Piece window use the Application
Context to open the appropriate
application-specific user interface
window.

The Constraints panel of the Marker
Piece Window contains a list of all
the specified Constraints for this
location in the beamline model.

The Application Context must be set for 
TRANSPORT to Open the TRANSPORT 

Fitting Constraints Window

Figure 46. Marker Piece Window Constraints and Diagnostics.

With TRANSPORT as the selected Application Context
in the Marker Piece Window, pressing the Open button in
the Constraints panel will open the TRANSPORT Fitting
Constraints Window (Figure 46).

To open the Transport Fitting
Constraints Window the Application
Context switch must be set for
TRANSPORT.
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Fitting Constraints Window
A TRANSPORT Fitting Constraints Window is opened
by double-clicking any Marker or Final Piece in the
beamline model. The Open button in the Constraints panel
of the Marker Piece Window opens the Fitting Constraints
Window (Figure 46) for the current Application Context.
The Application Context can be set in the Document
window or directly in the Marker Piece window.

The Constraint Expression field at the top of the Fitting
Constraints Window (Figure 47) can be used to directly
enter expressions in terms of Named Parameters, Fitting
Variables and TRANSPORT output parameters. After
assigning a Fit Value and Tolerance, the Accept button is
used to add the Constraint to the list at the bottom of the
window. Figure 47 illustrates the primary features of the
Transport Fitting Constraints Window.

Transport Fitting Constraints
Windows are accessed from Marker
or Final Pieces placed in the beamline
model.

The Constraint Expression field at the
top of the Fitting Constraints Window
can be used to directly enter
expressions defined in terms of Named
Parameters, Fitting Variables as well as
a variety of TRANSPORT output
parameters.

Specify a Value and Tolerance 
to the "Fit" Constraint 

Type in Mathematical Operators 
and Functions directly or use the 

Operators Panel

The "Accept"  Button accepts the 
user-specified  Expression, Value
 and Tolerance and adds it to the 

Constraint Experession List 
at the bottom of the window

The "Delete" Button  will Remove 
a Selected Constraint from the 

Constraint Expression List

Make a selection the Constraints 
List to edit the Expression and 
change the Value or Tolerance

Enter an Algebraic Constraint Expression in 
terms of TRANSPORT program variables and 
user-specified Parameter and Fitting Variables

Figure 47. Transport Fitting Constraints Window.
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Several TRANSPORT output parameters can be selected
for use in Constraint Expressions. Table 7 lists the
TRANSPORT keywords (output parameters) that are
supported in Constraint Expressions. Each category in
Table 7 is represented in the point & click interface of the
TRANSPORT Fitting Constraints Window.

Several TRANSPORT output parameters
can be selected for use in Constraint
Expressions.

Table 7. TRANSPORT Keywords for use in Constraint Expressions.

The Beam Matrix, Correlation Matrix and Transfer Matrices
are selected with the radio buttons shown in Figure 47. The
Matrix panel in the lower left portion of the window will
reflect the current matrix selection and is used to select
specific matrix elements for all matrices. The pop-ups for
the first-, second- and third-order Transfer Matrices are used
to specify Regular and Auxiliary Matrices. The second- and
third-order Transfer Matrices also have pop-ups for the
additional dimensions required for these selections.

Beam Matrix (i,j =1,6) Keyword
Reduced Sigma Matrix Element S ij

Correlation Matrix  (i,j =1,6) Keyword
Beam Correlation Matrix Element C ij

Transfer Matrices (i,j,k,l =1,6) Keyword
1st-Order Transfer Matrix Element R ij
2nd-Order Transfer Matrix Element T ijk
3rd-Order Transfer Matrix Element U ijkl

Transfer Matrices (i,j,k,l =1,6) Keyword
1st-Order Auxiliary Matrix RA ij
2nd-Order Auxiliary Matrix TA ijk
3rd-Order Auxiliary Matrix UA ijkl

Beam Centroids Keyword
Horizontal Beam Centroid Position XBEAM
Horizontal Beam Centroid Angle XPBEAM
Vertical Beam Centroid Position YBEAM
Vertical Beam Centroid Angle YPBEAM
Longitudinal Beam Centroid Position LBEAM
Longitudinal Beam Centroid Angle DELBEAM

Beam Envelopes Keyword
Horizontal Beam Half Width XBEAM
Horizontal Beam Half Angle XPBEAM
Vertical Beam Half Width YBEAM
Vertical Beam Half Angle YPBEAM
Longitudinal Beam Half Width LBEAM
Longitudinal Beam Half Angle DELBEAM

Floor Coordinates Keyword
Beamline Accumulated Length L
Floor Coordinate X Value XFLOOR
Floor Coordinate Y Value YFLOOR
Floor Coordinate Z Value ZFLOOR
View Reference Trajectory Angle YAW
Reference Trajectory Horz. Angle PITCH
Net Rotation Angle about TrajectoryROLL
Elevation ELEVATION

Lattice Functions Keyword
Accelerator Function BetaX BETAX
Accelerator Function AlphaX ALPHAX
Accelerator Function BetaY BETAY
Accelerator Function AlphaY ALPHAY
Accelerator Function EtaX ETAX
Accelerator Function DeltaX DETAX
Accelerator Function EtaY ETAY
Accelerator Function DeltaY DETAY

The Beam Matrix, Correlation Matrix
and Transfer Matrices are selected
with radio buttons; the Matrix panel
in the lower left portion of the
window is used to select specific
matrix elements for all matrices.



PBO Lab 2.0 User Manual Supplement: TRANSPORT Module

96

There are also pop-up controls, which have several
selections each, for four different categories: Beam
Envelopes, Beam Centroids, Lattice (Accelerator)
Functions as well as Floor Coordinates and Orientation
variables. You don’t need to know the TRANSPORT
keywords in order to formulate a Constraint Expression
with TRANSPORT output parameters. Simply chose a
category, either from the matrix radio buttons or the
various pop-up controls. Use the matrix panel to select a
specific matrix element or make a selection from one of
the pop-ups; the keyword for your selection will be
generated automatically in the Constraint Expression Field
at the top of the window. After assigning a Fit Value and
Tolerance, use the Accept button to add the constraint to
the list at the bottom of the window.

The Constraint Expression list at the bottom of the window
contains all of the Fitting Constraints defined for this
location in the beamline model. To select an existing
Constraint Expression click on the entry in the list. The
selection will be highlighted and the edit fields at the top
of the window will be updated with the selection. Press
the Accept button to update the expression with any
changes. The Delete button is used to remove an existing
constraint. Select the constraint in the Constraint
Expression list and press the Delete button. A constraint
can also be deleted directly from the Marker Piece window
without opening the Fitting Constraints Window. Select
the constraint in the constraints list in the Marker (or Final)
Piece Window and then press the Remove button in the
Constraint panel.

The expression list in the Fitting Constraints Window
includes only the constraints for that location in the
beamline. Other constraints may be specified at different
locations with additional Marker or Final Pieces. All of the
user-specified Fitting Constraint Expressions for the entire
beamline model are organized in the Constraint Expressions
List Window, which is described in the next Section.

Any keyword for a TRANSPORT
output parameters including matrix
elements, may be typed directly in the
Constraint Expression field. For
example “T346” would be entered as
the keyword for the second-order
Transfer matrix element T3,4,6.

The Constraint Expression list at the
bottom of the window contains all
of the fitting constraints defined for
this location in the beamline model.
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Constraint Expressions List Window
Multiple Marker and Final Pieces can be used to specify
Fitting Constraints at different locations in the beamline
model. PBO Lab provides a Constraint Expressions List
Window that groups all of the application-specific
constraints over the entire beamline model. The Constraint
Expressions List Window (shown in Figure 48) is opened
from the TRANSPORT Commands menu.

PBO Lab provides a Constraint
Expressions List Window that groups
all of the application-specific user-
specified constraints over the entire
beamline model.

The Fitting Constraints List Window provides 
access to all of the TRANSPORT Fitting 

Constraints for the entire beamline model

Double-Click an entry in the List 
Window to open the corresponding 

Marker or Final Piece Window

Figure 48. Constraint Expressions List Window.

This List Window provides quick access to TRANSPORT
Fitting Constraints over the entire beamline. Simply
double click an entry in the list to open the associated
Marker or Final Piece Window. Only TRANSPORT
Fitting Constraints are contained in this window. Other
Applications have their own List Windows that are
accessed from their respective Command Menus.

PBO Lab List Windows may be resized to accommodate
the number of entries. The columns in the List Windows
may also be resized by placing the mouse over the column
divider in the header of the List Window. The arrow cursor
will turn into a cross-hair cursor and the column can be
resized by holding down the mouse button and draging
the column divider to the desired position.

All of the user-specified Fitting
Constraint Expressions for the entire
beamline model are organized in the
Fitting Constraint Expressions List
Window.

List Windows may be resized to
accommodate the number of entries.
Column widths can also be adjusted
within the List Windows.
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Perform Fitting
There are two options for running TRANSPORT with the
“Write Input and Run Transport” Command. The
Submenu for this command (Figure 49), can be used to
run TRANSPORT “with Fitting” or “without Fitting”.
Once Fitting Variables and Constraints have been defined,
the “with Fitting” option will generate the required native
input to execute TRANSPORT with fitting. It is not
necessary to remove Fitting Variables and Constraints from
the beamline model in order to execute
TRANSPORT without fitting. The only difference
between the two options (with or without fitting) is that
PBO Lab will not include the FIT instruction in the native
TRANSPORT input if “without Fitting” is selected.
Otherwise the Fitting Variables and Constraint
Expressions are unchanged in the beamline model.

The “Write Input and Run Transport”
Command can be used to run
TRANSPORT “with Fitting” or
“without Fitting”.

Run Transport Fitting from the 
TRANSPORT Commands Menu

Figure 49. Execute TRANSPORT and Perform Fitting.

Output File Options in the
TRANSPORT Options Window can be
used to specify fitting output during
and after fitting.

Output results and diagnostics for fitting are found in the
Transport Output Window, which is automatically opened
following the execution of TRANSPORT. Output File
Options in the TRANSPORT Options Window can be used
to specify fitting output during and after fitting.
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After a fitting operation, Fitting
Variables are displayed in an Update
Window along with Parameter
Algebraic Expressions.

The Update Window allows you to
examine fitted parameter values and
evaluated parameter expressions
before deciding if the beamline
model should be updated. The
beamline model is not changed until
the new values are explicitly accepted
in the Update Window.

In addition to the native Transport Output for fitting, PBO
Lab provides an Update Window for examining the fitted
parameter values and evaluated parameter expressions
before deciding if the beamline model should be updated
with any or all of these new values. The following Section
describes the Update Variables & Expressions Window.

Update Variables & Expressions
After TRANSPORT has completed a fitting task, the new
values for Fitting Variables and Parameter Expressions
can be used to update Piece Parameters in the beamline
model. The Update Parameter Variables & Expressions
Window, shown in Figure 50, is automatically opened
following the execution of TRANSPORT. The Update
Window is used to examine the new values for Fitting
Variables and Parameter Expressions and to update the
beamline model with those values if desired.

Scrolling List of 
User Specified 

Fitting Variables

Scrolling List of User 
Specified  Parameter 

Algebraic Expressions

Update Only Selected 
Variable Parameters

Update All Variable 
Parameters in the List

Parameter Values 
Before and After Fitting

Evaluated Parameter 
Expressions

Click on a Parameter in the 
List to Select it for Update

Double Click a Parameter 
to Open its Piece Window

Update Any or All 
Evaluated Parameter 

Expressions

Figure 50. Update Variables and Expressions Window.



Double-click a Fitting Variable or
Parameter Expression to open the
Piece Window for that parameter.

Both the Variables and Expressions
lists have buttons for updating the
specific Piece Parameters in the
beamline model with the new values
displayed in the Update Window.

Using the mouse to double-click an
entry in the Update Window, will
open the Piece Window for that
parameter.

If the Update Window is closed prior
to updating the beamline, then the
fitting results will be disposed and the
beamline model will remain
unchanged.

Refer to the “TRANSPORT User
Manual” for additional information
on the TRANSPORT program.
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The Update Window contains two scrolling lists, one for
Fitting Variables and the other for Parameter Expressions.
The list at the top of the window displays all of the user
specified TRANSPORT Fitting Variables for the entire
beamline model along with the initial and final values.

The list at the bottom of the Update Window contains all
of the Piece Parameters that have been specified by
Parameter Algebraic Expressions through out the beamline
model, along with the final evaluation of those expressions.

Both the Variables and Expressions lists have buttons for
updating the specific Piece Parameters in the beamline
model with the new values displayed in the Update
Window. The Update All Values button can be used to
update all of the parameters in one step. Alternatively, the
Update Selected Value button can be used to update
parameters individually. (There are identical buttons for
Parameter Algebraic Expressions in the lower half of the
window.) To update Piece Parameters individually make
a selection in the list of parameters and press the Update
Selected Value button. When a selection is made in the
list it will be highlighted. Using the mouse to double-
click an entry in the list will open the Piece Window
containing that parameter.

The Update Window can be left open and the beamline
will not be updated with the new parameter values until
one of the Update buttons is used. However, if the window
is closed prior to updating the beamline, then the fitting
results are disposed and the beamline model will be
unchanged.

This concludes the TRANSPORT Fitting Chapter and
the TRANSPORT Application Module Supplement for
the Particle Beam Optics Laboratory. Additional
information about the TRANSPORT program can be
found in the “TRANSPORT User Manual.” Refer to the
PBO Lab User Manual for general information about
the PBO Lab user interface..
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